


2 Copyright

Sharp AR-C360P EFI User�s Software Installation Guide - 2

Copyright
Sharp AR-C360P EFI User�s Software Installation Guide

P/N 59379501, Revision 1.1

September, 2005

Every effort has been made to ensure that the information in this document is complete, accurate, and up-to-date. Sharp 
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While all reasonable efforts have been made to make this document as accurate and helpful as possible, we make no warranty 
of any kind, expressed or implied, as to the accuracy or completeness of the information contained herein.

Copyright © 2005 Sharp Electronics Corp. and Electronics for Imaging, Inc. All rights reserved. 

This publication is protected by copyright, and all rights are reserved. No part of it may be reproduced or transmitted in any form 
or by any means for any purpose without express prior written consent from Electronics for Imaging, Inc. Information in this 
document is subject to change without notice and does not represent a commitment on the part of Electronics for Imaging, Inc. 
or Sharp

This publication is provided in conjunction with an Sharp Electronics Corp. product (the �Product�) which contains EFI software 
(the �Software�). The Software is furnished under license and may only be used or copied in accordance with the terms of the 
Software license set forth below. 

This product may be covered by one or more of the following U.S. Patents:þ 4,716,978, 4,828,056, 4,917,488, 4,941,038, 
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6,112,665, 6,116,707, 6,122,407, 6,134,018, 6,141,120, 6,166,821, 6,173,286, 6,185,335, 6,201,614, 6,215,562, 6,219,155, 
6,219,659, 6,222,641, 6,224,048, 6,225,974, 6,226,419, 6,238,105, 6,239,895, 6,256,108, 6,269,190, 6,271,937, 6,278,901, 
6,279,009, 6,289,122, 6,292,270, 6,299,063, 6,310,697, 6,321,133, 6,327,047, 6,327,050, 6,327,052, 6,330,071, 6,330,363, 
6,331,899, 6,340,975, 6,341,017, 6,341,018, 6,341,307, 6,347,256, 6,348,978, 6,356,359, 6,366,918, 6,369,895, 6,381,036, 
6,400,443, 6,429,949, 6,449,393, 6,476,927, 6,490,696, 6,501,565, 6,519,053, 6,539,323, 6,543,871, 6,546,364, 6,549,294, 
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Trademarks
Auto-Count, ColorCal, ColorWise, Command WorkStation, EDOX, EFI, Fiery, the Fiery logo, MicroPress, Printcafe, PrinterSite, 
Prograph, Proteus, and Spot-On are registered trademarks of Electronics for Imaging, Inc., in the U.S. Patent and Trademark 
Office and/or certain other foreign jurisdictions. Bestcolor is a registered trademark of Best GmbH in the U.S. Patent and 
Trademark Office. 

AutoCal, Digital StoreFront, DocStream, Fiery Link, FreeForm, Hagen, Intelligent Device Management, Logic, OneFlow, PrintFlow, 
PrintMe, PrintSmith Site, PrintSmith, PSI Flexo, PSI, SendMe, Splash, VisualCal, the EFI logo, Essential to Print are trademarks 
of Electronics for Imaging, Inc.  Best, the Best logo, Colorproof, PhotoXposure, Remoteproof, and Screenproof are trademarks of 
Best GmbH. 

All other terms and product names may be trademarks or registered trademarks of their respective owners, and are hereby 
acknowledged.
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Legal Notices 

APPLE COMPUTER, INC. (�APPLE�) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT 
LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, 
REGARDING THE APPLE SOFTWARE. APPLE DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS 
REGARDING THE USE OR THE RESULTS OF THE USE OF THE APPLE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND 
PERFORMANCE OF THE APPLE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT 
PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. 

IN NO EVENT WILL APPLE, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, 
INCIDENTAL OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, 
LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE APPLE SOFTWARE 
EVEN IF APPLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT 
APPLY TO YOU. Apple�s liability to you for actual damages from any cause whatsoever, and regardless of the form of the action 
(whether in contract, tort [including negligence], product liability or otherwise), will be limited to $50. 

PANTONE® Colors displayed in the software application or in the user documentation may not match PANTONE-identified 
standards.þ Consult current PANTONE Color Publications for accurate color. PANTONE® and other Pantone, Inc. trademarks are 
the property of Pantone, Inc. © Pantone, Inc., 2001. 

Pantone, Inc. is the copyright owner of color data and/or software which are licensed to Electronics for Imaging, Inc.,þto distribute 
for use only in combination with the products, or software of Electronics for Imaging, Inc. PANTONE Color Data and/or Software 
shall not be copied onto another disk or into memory except as part of the delivery of the Electronics for Imaging, Inc., products 
or software.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

FCC Information
WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by 
the manufacturer could void the user�s authority to operate this equipment. 

Class B Declaration of Conformity
This equipment has been tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC 
rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy and if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not 
occur in a particular installation. 

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-
approved equipment or unshielded cables is likely to result in interference to radio and TV reception. The user is cautioned that 
changes and modifications made to the equipment without the approval of manufacturer could void the user�s authority to operate 
this equipment.

Industry Canada Class B Notice
This Class B digital apparatus complies with Canadian ICES-003.
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Avis de Conformation Classe B de l�Industrie Canada 
Cet appareil numérique de la Classe B est conforme à la norme NMB-003 du Canada.

RFI Compliance Notice
This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on 
system level (to simulate normal operation conditions). However, it is possible that these RFI Requirements are not met under 
certain unfavorable conditions in other installations. It is the user who is responsible for compliance of his particular installation.

Dieses Gerät wurde sowohl einzeln als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung 
der Funkentstörbestimmungen geprüft. Es ist jedoch möglich, dass die Funkentstörbestimmungen unter ungünstigen Umständen 
bei anderen Gerätekombinationen nicht eingehalten werden. Für die Einhaltung der Funkentstörbestimmungen einer gesamten 
Anlage, in der dieses Gerät betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the 
appropriate cables.

Die Einhaltung zutreffender Bestimmungen hängt davon ab, dass geschirmte Ausführungen benützt werden. Für die Beschaffung 
richtiger Ausführungen ist der Betreiber verantwortlich.

Software License Agreement
YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS SOFTWARE. IF YOU DO NOT 
AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE. INSTALLING OR USING THE 
SOFTWARE INDICATES THAT YOU AGREE TO AND ACCEPT THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ACCEPT 
THE TERMS OF THIS AGREEMENT YOU MAY RETURN THE UNUSED SOFTWARE FOR A FULL REFUND TO THE PLACE OF PURCHASE. 

License
EFI grants you a non-exclusive license to use the Software and accompanying documentation (�Documentation�) included with 
the Product. The Software is licensed, not sold. You may use the Software solely for your own customary business or personal 
purposes. You may not rent, lease, sublicense or lend the Software or use the Software in any time sharing, service bureau, or 
similar arrangement. 

You may not make or have made, or permit to be made, any copies of the Software or portions thereof, except one (1) copy for 
backup or archive purposes in support of your use of the Software as permitted hereunder. You may not copy the Documentation. 
You may not attempt to localize, translate, disassemble, decompile, decrypt, reverse engineer, discover the source code of, 
modify, create derivative works of, or in any way change any part of the Software.

The terms, conditions, and restrictions in the License Agreement apply to all bug fixes, patches, releases, release notes, updates, 
and upgrades related to the Software.

Proprietary Rights
You acknowledge and agree that all rights, title and interest, including all intellectual property rights, in and relating to the 
Software, Documentation and all modifications and derivative works thereof are solely owned by and shall remain with EFI and 
its suppliers. Except for the express limited license granted above to use the Software, no right or license of any kind is granted. 
You receive no rights or license under any patents, copyrights, trade secrets, or trademarks (whether registered or unregistered). 
You agree not to adopt, register, or attempt to register any EFI trademark or trade name (�EFI Mark�) or any confusingly similar 
mark, URL, internet domain name, or symbol as your own name or the name of your affiliates or products, and not to take any 
other action which impairs or reduces the trademark rights of EFI or its suppliers. 

Confidentiality
The Software is confidential, proprietary information of EFI and you may not distribute or disclose the Software. You may, 
however, permanently transfer all of your rights under this Agreement to another person or legal entity provided that: (1) such 
a transfer is authorized under all applicable export laws and regulations, including the U.S. Export Administration Regulations, 
(2) you transfer to the person or entity all of the Software and Documentation (including all copies, updates, upgrades, prior 
versions, component parts, the media and printed materials, and this Agreement); (3) you retain no copies of the Software and 
Documentation, including copies stored on a computer; and (4) the recipient agrees to the terms and conditions of this 
Agreement. 
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Remedies and Termination
Unauthorized use, copying, or disclosure of the Software, or any breach of this Agreement will result in automatic termination of 
this license and will make available to EFI other legal remedies. In the event of termination, you must destroy all copies of the 
Software, Documentation, and all component parts thereof. All provisions of this Agreement relating to disclaimers of warranties, 
limitation of liability, remedies, damages, governing law, jurisdiction, venue, and EFI�s proprietary rights shall survive 
termination.

Limited Warranty and Disclaimer
EFI warrants to the original purchaser (�Customer�) for thirty (30) days from the date of original purchase from EFI or its 
authorized retailer that the Software will perform in substantial conformance to the Documentation when the Product is used as 
authorized by EFI�s specifications. EFI warrants the media containing the Software against failure during the above warranty 
period. EFI makes no warranty or representation that the Software will meet your specific requirements, that the operation of 
the Software will be uninterrupted, secure, fault-tolerant, or error free, or that all defects in the Software will be corrected. EFI 
makes no warranty, implied or otherwise, regarding the performance or reliability of any third party products (software or 
hardware. THE INSTALLATION OF ANY THIRD PARTY PRODUCTS OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS 
WARRANTY. IN ADDITION, USE, MODIFICATION, AND/OR REPAIR OF THE PRODUCT OTHER THAN AS AUTHORIZED BY EFI WILL 
VOID THIS WARRANTY.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, EFI 
MAKES AND YOU RECEIVE NO WARRANTIES OR CONDITIONS ON THE SOFTWARE, EXPRESS, IMPLIED, STATUTORY, OR IN ANY 
OTHER PROVISION OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND EFI SPECIFICALLY DISCLAIMS ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF THIRD 
PARTY RIGHTS. 

Limitation of Liability
TO THE MAXIMUM EXTENT PERMITTED BY LAW, EFI AND ITS SUPPLIERS SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING 
LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES 
ARISING FROM THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE OR FAILURE OF THE SOFTWARE, HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF EFI HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE PRODUCT REFLECTS THIS ALLOCATION OF RISK. BECAUSE 
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL 
DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

You are hereby notified that Adobe Systems Incorporated, a Delaware corporation located at 345 Park Avenue, San Jose, CA 
95110-2704 (�Adobe�) is a third-party beneficiary to this agreement to the extent that this agreement contains provisions which 
relate to your use of any software, font programs, typefaces, and/or trademarks licensed or supplied by Adobe. Such provisions 
are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to EFI. ADOBE WILL HAVE NO LIABILITY 
WHATSOEVER TO YOU FOR ANY ADOBE SOFTWARE OR TECHNOLOGY LICENSED HEREUNDER.

Export Controls
EFI�s Products are subject to U.S. export laws and regulations, including the U.S. Export Administration Regulations, as well as 
foreign export laws and regulations. You agree that you will not use, distribute, transfer, export, or re-export any portion of the 
Product or the Software in any form in violation of any applicable laws or regulations of the United States or the country in which 
you obtained them.

U.S. Government Restricted Rights:
Use, duplication, or disclosure of the Software by the United States Government is subject to restrictions as set forth in FAR 
12.212 or DFARS 227.7202-3 -227.7202-4 and, to the extent required under U.S. federal law, the minimum restricted rights as 
set out in FAR 52.227-14, Restricted Rights Notice (June 1987) Alternate III(g)(3)(June 1987) or FAR 52.227-19 (June 1987). 
To the extent any technical data is provided pursuant to the Agreement, such data is protected per FAR 12.211 and DFARS 
227.7102-2 and to the extent explicitly required by the U.S. Government, is subject to limited rights as set out in DFARS 
252.227.7015 (November 1995) and DFARS 252.227-7037 (September 1999). In the event that any of the above referenced 
agency regulations are modified or superceded, the subsequent or equivalent regulation shall apply. The name of the Contractor 
is Electronics for Imaging. 
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General
The rights and obligations of the parties related to this Agreement will be governed in all respects by the laws of the State of 
California exclusively, as such laws apply to contracts between California residents performed entirely within California. The 
United Nations Convention on Contracts for the International Sale of Goods and any other similar convention does not apply to 
this Agreement. For all disputes related to this Agreement, you consent to the personal and exclusive jurisdiction and venue of 
the state courts in San Mateo County, California and the federal court for the Northern District of California. This Agreement is 
the entire agreement held between us and supersedes any other communications or advertising with respect to the Software. If 
any provision of this Agreement is held invalid, such provision shall be deemed modified to the extent necessary to be enforceable 
and the other provisions in this Agreement shall continue in full force and effect.

If you have any questions, please see EFI�s web site at www.efi.com.

Electronics for Imaging

303 Velocity Way

Foster City, CA 94404
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This manual is part of a set of Fiery Network Controller for Sharp 
AR-C360P , herein referred to as the �Fiery,� documentation that 
includes the following manuals for users and system 
administrators. Most are available as Acrobat PDF (Portable 
Document Format) files on the User Documentation CD.

� The User Software Installation Guide describes how to install 
software from the User Software CD to enable users to print to 
the Fiery Network Controller for Sharp AR-C360P  with the EFI 
PostScript driver, and also describes setting up printing 
connections to the Fiery.

� The Configuration Guide explains basic configuration and 
administration of the Fiery for the supported platforms and 
network environments. It also includes guidelines for setting up 
UNIX, Windows NT 4.0/2000/Server 2003, and Novell NetWare 
servers to provide printing services to users.

� The Printing Guide describes the printing features of the Fiery 
for users who send jobs from their computers using the EFI 
PostScript driver.

� The Color Guide provides information on managing the color 
output of the Fiery. It explains how to calibrate your Fiery and 
take advantage of the ColorWise® color management system, as 
well as features in ColorWise Pro Tools�. 

� The Fiery color Reference addresses concepts and issues 
associated with managing color output of the Fiery and outlines 
key workflow scenarios. In addition, it offers information on 
printing color documents from popular Microsoft Windows and 
Apple Mac OS applications.

� The Job Management Guide explains the functions of the job 
management utilities, including Command WorkStation�, 
Command WorkStation LE�, and DocBuilder Pro�, and how you 
can use them to monitor and control jobs on the Fiery. 
This manual is intended for an operator or administrator, or a 
user with the necessary access privileges, who monitors and 
manages job flow, performs color calibration, and troubleshoots 
problems that may arise.

About the 
Documentation
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This manual describes how to install user software for the Fiery 
Network Controller for Sharp AR-C360P  and how to set up 
printing from Microsoft Windows and Apple Mac OS computers. 
For information about setting up network servers and clients to 
use the Fiery, see Chapter 2 of the Configuration Guide. For 
general information on using your computer, application software, 
or network, see the manuals that accompany those products.

Note:The term �Fiery� is used in this manual to refer to the Fiery 
Network Controller for Sharp AR-C360P . The name �Aero� is used 
in illustrations to represent the Fiery. The term �Windows� is used 
to refer to Windows 98, Windows Me, Windows NT 4.0, Windows 
2000, Windows XP, and Windows Server 2003, wherever 
appropriate.

The Fiery includes support for Fiery WebTools� and software for 
Command WorkStation, which enables an operator to manage all 
jobs sent to the Fiery. Although it may not be the case at all sites, 
the documentation for this product assumes the presence of an 
operator who controls and manages jobs sent by users 
from remote workstations.

About this manual
This manual covers the following topics:

� Installing printer files on Windows and Mac OS computers

� Setting up printing connections on Windows and Mac OS 
computers

� Installing Fiery® utilities and other user software on Windows 
and Mac OS computers

Introduction
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Fiery WebTools
Fiery WebTools allow you to manage your Fiery remotely from the 
Internet or from your company�s intranet. You access Fiery 
WebTools from the Fiery WebTools home page.

Fiery 
WebTools

Summary
For more 

information

Status Shows you the jobs currently 
processing and printing.

See Chapter 8 of the 
Printing Guide.

WebLink Provides a link to another web 
page, provided you have a 
valid Internet connection.

See the Printing 
Guide Chapter 8 and 
the Configuration 
Guide Chapter 6.

WebDownloa
der

Allows you to download 
PostScript, PCL, EPS, and PDF 
files to the Fiery.

See the Printing 
Guide.

WebSetup 
(Windows 
only)

Allows you to modify the Fiery 
configuration (Setup) 
remotely. This function 
requires the Administrator 
password, if one has been set.

See the Configuration 
Guide.
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System requirements
To install the Fiery user software on a Windows or Mac OS 
computer, the computer must be equipped with a built-in or 
external CD-ROM drive. The following table lists the minimum 
system requirements.  

Minimum 
requirements for

Windows 98/
Me

Windows NT 4
.0

Windows 
2000/XP/

Server 2003
Mac OS

Operating system Windows 98/Me Windows NT 
with NT Service 
Pack 6

Windows 2000 
with Service 
Pack 4
Windows XP 
with Service 
Pack 1
Windows Server 
2003 Standard 
Edition, 
Enterprise 
Edition, or 
Datacenter 
Edition, all the 
32-bit version
(printer driver 
only supported)

Mac OS 8.6 to 
9.2 
Mac OS X 10.1 
to 10.3 Classic 
Mode 
Mac OS X 
10.2.1 or higher 
Native Mode

Memory for printing 
and Fiery utilities (Fiery 
Downloader�, 
ColorWise Pro Tools, 
and Fiery Spooler 
[Mac OS only])

8MB of RAM for printing
128MB of RAM for printing and utilities

32MB of RAM 
for printing
64MB of RAM 
for utilities

Networking protocol IPX/SPX, TCP/IP, or AppleTalk AppleTalk (Ether 
Talk supported)
TCP/IP 
(required for 
MAC OS X 10.2 
or later)
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Networking protocol for 
Fiery® utilities

TCP/IP TCP/IP 
(required
for MAC OS X 
10.2 or later) 
(EtherTalk 
supported)

Note:AppleTalk 
can be used for 
Fiery Downloader. 
Fiery WebTools� 
is supported with 
Classic Mode only.

PostScript printer 
driver

Adobe 
PostScript 
Printer Driver 
for Windows 
(included with 
user software)

Adobe 
PostScript 
Printer Driver 
for Windows NT 
(included with 
user software)

Microsoft 
PostScript 
Printer Driver 
for Windows 
2000/XP/Server 
2003 (included 
with Windows 
2000/XP/Server 
2003 operating 
systems)
The PostScript 
Printer 
Description 
(PPD) files for 
Windows XP are 
provided for 
Windows Server 
2003

Adobe 
PostScript 
Printer Driver 
(included with 
user software)

PCL printer driver PCL Printer Driver for Windows only (included on 
CD1)

Minimum 
requirements for

Windows 98/
Me

Windows NT 4
.0

Windows 
2000/XP/

Server 2003
Mac OS
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Fiery WebTools� � Java-enabled web browser: 
Internet Explorer v5.5 or higher with SP2 (Windows 98/Me/NT 4.0/2000)
Internet Explorer v6.0 (Windows 2000/XP/Server 2003)
Internet Explorer v5.0 for Mac OS

Note:Microsoft releases frequent updates to its browsers. As support cannot 
be guaranteed for all versions, use the versions specified for best results.

� A monitor and video memory that supports 16-bit color at a minimum 
resolution of 800 x 600

� A TCP/IP-enabled network and the IP address or DNS name of the Fiery
� Web Services enabled on the Fiery

Command WorkStation 
(Windows only)

� Windows-based computer with a 200-MHz or greater  
Pentium processor

� 60MB of available hard disk space for installation
� At least 2x CD-ROM drive
� A monitor that supports 16-bit color at a minimum 

resolution of 1024 x 768
� 128MB of RAM
� Video adapter card with 2MB of video memory
� TCP/IP networking protocol installed

�

Command WorkStation 
LE (Mac OS X Native 
Mode)

� 300MHz Apple Macintosh G3
� 128MB RAM
� 80MB hard disk space (installation)
� 500MB hard disk space�recommended for generating full previews of raster 

files and handling large PS/PDF files
� Operating system�MAC 10.2.4 or later
� Java for Mac OS X�Java 2 Platform, Standard Edition, version 1.3.1

Note:More system resources (RAM and hard disk space) and a faster processor 
will lead to better system performance.

DocBuilder Pro 
(available as an option) 
on Command 
WorkStation (Windows 
only)

In addition to requirements for Command 
WorkStation:
� Windows-based computer with 333-MHz Pentium 

processor
� 90MB of available hard disk space
� Dongle to be installed on parallel port for every client 

workstation

�

Parallel port 24MB of RAM 32MB of RAM 64MB of RAM

Minimum 
requirements for

Windows 98/
Me

Windows NT 4
.0

Windows 
2000/XP/

Server 2003
Mac OS
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Other Network Requirements

UNIX (TCP/IP) 
workstation

� Standard TCP/IP connectivity (for example, Sun SPARCStation or Silicon 
Graphics workstation with Solaris version 2.5 or later, or SunOS version 4.1.x 
software)

� TCP/IP printing software that conforms to RFC1179 (Berkeley lpd protocol)

IPX (Novell) network � Novell server
� Novell NetWare software version 4.x or 5.x
� NDPS gateway in Netware 5.x
� Support for Ethernet SNAP, Ethernet II, Ethernet 802.3, and Ethernet 802.2 

frame types
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This chapter describes the procedures for installing software and 
setting up printing from a computer using a supported version of 
Windows (Windows 98/Me, NT 4.0, 2000, XP or Server 2003).

The general steps for installing the software are as follows:

� Install the PostScript printer driver or PCL printer driver and 
corresponding printer driver files and set up the printer driver to 
communicate with the Sharp AR-C360P.

� Install Fiery utilities and user software�EFI Fiery Mail Port, Fiery 
Remote Scan, Fiery Downloader, Fiery Printer Delete Utility, 
ColorWise Pro Tools, and Command WorkStation.

Note:If the computer is not intended to be used by the Sharp AR-
C360P administrator, Command WorkStation may not be required.

� Configure the connection for Fiery utilities and user software.

� Copy additional files from CD1 as required.

Chapter 1:
Installing 
User Software 
on a Windows 
Computer



11-17 Setting up PostScript or PCL printing with Windows 98/Me

Sharp AR-C360P EFI User�s Software Installation Guide - 17

Setting up PostScript or PCL printing with 
Windows 98/Me
To set up the Fiery as a PostScript or PCL printer, you must install 
the PostScript or PCL printer driver for Windows 98/Me and, for 
PostScript, the corresponding printer description file. You must 
also configure either a local connection for printing directly or a 
network connection for printing over the network.

If you are printing using SMB (Server Message Block), you can 
connect to the Fiery and install the printer drivers in a single 
procedure. For more information, see �Setting up SMB printing 
with Windows 98/Me� on page 1-29.

Note:The procedures for setting up printing with the PostScript 
and PCL printer drivers are similar. Either can, and should, be 
installed using the Installer program on CD1 supplied with the 
Sharp AR-C360P.

Installing the PostScript or PCL printer driver for 
Windows 98/Me
The following procedure describes installing the printer driver 
from CD1. Subsequent procedures describe configuring installable 
options and setting up the printer connection.

Note:It is strongly recommended that you use the supplied 
Drivers CD (CD1) to install the printer drivers. This will 
automatically also install the Sharp LPR utility, which greatly 
simplifies network connection to the printer over a TCP/IP 
connection. If you choose to use the standard Windows Add 
Printer Wizard, you will need to install this utility from the CD 
afterwards if you require these features.

To install the PostScript or PCL printer driver 
for Windows 98/Me

1. Insert CD1 into your CD drive and wait for the CD to autorun the setup 
program.
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If the CD does not autorun navigate to the CD root directory and 
double-click the setup.exe program to start the installer.

2. Choose your preferred language for the installer.

3. From the next screens after accepting the licensing agreement, follow the 
on-screen instructions to complete the driver installation.

You can run this procedure twice if you want more than one driver 
installed. For example, if you want the EFI PostScript driver and 
the PCL driver run the procedure once for each driver and choose 
the required driver each time. Choose a name for the installed 
driver that will indicate which driver and printer it is for.

For networked printers the installer will also install the Sharp LPR 
program, which makes connecting the printer over TCP/IP 
networks easy, and the Network Extension, which enables the 
driver to query the printer and automatically enable any optional 
hardware installed on it.
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For the Fiery PS driver the installer will also install the Job Monitor 
utility so that you can monitor the status of the printer and your 
print jobs directly from the Windows desktop.

4. When driver installation is complete you may wish to install other 
software utilities from the main installer screen. Information about each 
is available on the installer screen.
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Configuring installed options
After you have completed the printer driver installation, you may 
configure the driver for the optional hardware installed on the 
Sharp AR-C360P. This allows the driver to take advantage of these 
options. You can configure the options manually or, for TCP/IP 
network connections, you can use the Two-Way Communication 
feature to configure the options automatically.

Configuring installed options manually

The following procedure describes how to manually configure the 
Fiery for the options installed on the printer.

To configure options manually for 
Windows 98/Me

1. Click Start, choose Settings, and then choose Printers.

2. Right-click the appropriate printer icon and choose Properties from the 
context menu.

3. Click the Installable Options (PS) or Device Options (PCL) tab.

4. Select an installed option from the Available Options list.

5. In the PS driver click Add to move the option to the Installed Options list. 
This is not necessary in the PCL driver.

6. Click Apply, and then click OK.

Configuring installed options and updating print options 
settings automatically

If you have a TCP/IP-enabled network, you can automatically 
update your printer driver to reflect the options currently installed 
on the printer. When the printer driver is first installed, the 
options have default settings that were set up in Fiery Setup or 
ColorWise Pro Tools. When you update the printer driver with the 
Two-Way Communication feature, you allow the Fiery to complete 
the actual setting.
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The Two-Way Communication feature also updates Expert Color 
Settings options to reflect the current Color settings on the Fiery. 
To access the Expert Color Settings options, click the Expert 
Settings tab in the ColorWise print option bar of the Fiery printing 
tab of your PS printer driver. For more information, see Chapter 1 
of the Color Guide.

To configure installed options and update print 
options settings automatically for 
Windows 98/Me

1. In the Installable Options (PS) or Device Options (PCL) tab, select Two-
Way Communication.

2. Type the Sharp AR-C360P�s IP address or DNS name.

3. In the PS driver, to display the Sharp AR-C360P�s current default settings 
when opened, select Update Fiery Driver When Opened.

4. Click Update.

5. In the PS driver, to receive an e-mail notification after your job has been 
printed, select Enable E-mail Notification, and type in the e-mail address 
to which notification should be sent.

You will also receive e-mail notification of any errors that occur 
during printing.

Note:Enable E-mail Notification is displayed only if Email Service 
is enabled at Setup.

6. Click OK.

Completing the Windows 98/Me printer 
connection
To print from Windows 98/Me, you should already have set up 
network servers, if any, and set up the Fiery to accept print jobs 
from your computer.

To complete the Windows 98/Me connection, you must configure a 
connection on each Windows computer for the network.
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Completing the Windows 98/Me parallel port connection

Preparing a parallel port connection for Windows 98/Me requires 
specific BIOS settings on your computer, and specific port and 
printer settings for Windows 98/Me. In addition, the administrator 
may need to change the parallel port timeout in Fiery Setup if you 
choose to spool files to the Fiery, rather than print directly.

To prepare the Fiery and your computer for 
parallel port printing

1. Connect the Fiery to the parallel port on your computer.

For instructions, see Chapter 1 of the Configuration Guide.

2. In Network Setup > Port Setup > Parallel Port Setup on the printing unit 
Control Panel, set Enable Parallel Port to Yes.

For more information about Fiery Setup, see Chapter 4 of the 
Configuration Guide.

3. If you want to spool files to the Fiery, set Port Timeout in Seconds to 10.  
If you want to print directly to the Fiery, set Port Timeout in Seconds to 5.

4. In your computer�s BIOS settings, set Parallel Port Mode to ECP.

To access the BIOS settings, restart the computer and press the 
key indicated on your monitor as soon as the computer starts up. 
You may have to scroll through several menus to reach the 
parallel port settings. After setting the Parallel Port Mode to ECP, 
save your changed setting and exit.

To prepare the printer for parallel port printing

1. Click Start, choose Settings, and then choose Printers.

2. Click the appropriate printer icon and choose Properties from the File 
menu.

3. Click the Details tab, and in the �Print to the following port� menu, select 
LPT 1: (ECP Printer Port).
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Note:Check this selection carefully. It may read LPT 1: (Printer 
Port), which is not equivalent to LPT 1: (ECP Printer Port).

If this box does not read LPT 1: (ECP Printer Port), change the 
port setting now, as described in �To prepare the port for parallel 
port printing� on page 1-24, and then return to this procedure. 
You may need your Windows System CD.

4. If you changed the selection in the �Print to the following port� menu, 
click Apply.

A Warning dialog box may appear, stating that fonts you 
downloaded to the previously selected port may be lost; click OK.

5. Click Spool Settings.

6. Select either �Spool print jobs so program finishes printing faster� or 
�Print directly to the printer.�

The selection you make depends on the port timeout you set in 
step 3 on page 1-22:

� If you set the Port Timeout in Seconds to 10, you can select 
either option; however, spooling is faster.

� If you set the Port Timeout in Seconds to 5, select �Print directly 
to the printer.�

7. Select �Disable bi-directional support for this printer� and click OK.

8. Click Apply.

You are now ready to print from your applications to the Fiery with 
the parallel port. To confirm the connection, print a Test page.
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9. Click the General tab.

10. Click Print Test Page and click OK.

11. In the Job Notes field, type user and job identification information, and 
click OK.

If the Test page prints successfully, you are ready to print from 
the computer.

Perform the following procedure in Windows 98/Me only if the 
LPT1 port is not currently set to ECP Printer Port.

To prepare the port for parallel port printing  
in Windows 98/Me

1. Click Start, choose Settings, and then choose Control Panel.

2. Double-click System.

The System Properties dialog box appears.

3. Click the Device Manager tab.
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4. Double-click Ports.

5. Double-click the port with LPT1 in its name.

6. In the (LPT1) Properties dialog box, click the Driver tab and then click 
Update Driver.

The Update Device Driver Wizard dialog box appears.

7. Click Next.
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8. Select �Display a list of all the drivers in a specific location, so you can 
select the driver you want,� and then click Next.

9. Select �Show all hardware.�

10. From the Manufacturers list, select �(Standard port types).� From the 
Models list, select �ECP Printer Port� (not Printer Port). Click Next.

11. Click Yes in the Update Driver Warning dialog box.

12. Click Next.

13. Click Finish, then close the Printer Port Properties and System Properties 
dialog boxes.

You must restart your computer to activate the new settings. After 
Windows 98/Me restarts, complete the procedure described in �To 
prepare the printer for parallel port printing� on page 1-22.

Completing the Windows 98/Me IPX/SPX or IPX (Novell) 
connection

If you are printing through a Novell server, the Novell network and 
file server should be set up before you begin. The file server 
should be configured with a print server and print connection for 
the Sharp AR-C360P. For details, see your NetWare 
documentation and Chapter 2 of the Configuration Guide.
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To print from Windows 98/Me computers over IPX (Novell), you 
must first set up IPX/SPX protocols, and then configure the Sharp 
AR-C360P by choosing the IPX frame type and entering the 
settings for the port you use.

To select a frame type for IPX/SPX printing 
for Windows 98/Me

1. Click Start, choose Settings, and then choose Control Panel.

2. Double-click the Network icon.

Make sure that IPX/SPX-compatible Protocol is listed in the 
installed network components pane.

For instructions, see your Windows 98/Me documentation or 
contact Microsoft Technical Support.

3. Double-click the IPX/SPX-compatible Protocol icon.

4. Click the Advanced tab.

5. Select Frame Type in the Property list. 
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6. In the Value menu, choose the Frame Type that corresponds to the one 
set in Fiery Network Setup.

If necessary, print the Configuration page from the printing unit 
Control Panel to determine which frame type(s) are configured.

Note:Do not select Auto. Auto may not select the frame type 
specified on the Sharp AR-C360P.

7. Click OK and close the Network Control Panel.

8. When prompted to restart your computer, click Yes.

To set up a port for IPX (Novell) printing with 
Windows 98/Me

1. Click Start, choose Settings, and then choose Printers.

2. Click the appropriate printer icon and choose Properties from the File 
menu.

3. Click the Details tab and click Add Port.

A list of connection options appears.
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4. In the Add Port dialog box, specify the network path or click Browse for a 
display of your network environment.

5. If you are using a NetWare file server, double-click the icon for the 
NetWare file server to use for printing to the Sharp AR-C360P. 

6. Click the printer icon for the NetWare print queue you want to use, and 
then click OK.

7. In the Add Port dialog box, verify that the network path is updated and 
click OK.

Your print jobs are transmitted to the specified print queue on the 
Novell file server. The Sharp AR-C360P polls the file server, and if 
jobs are present, they are transmitted to the Fiery.

8. To confirm the connection, click the General tab, click Apply, and then 
click Print Test Page.

After the Test page prints successfully, you are ready to print from 
the computer.

Setting up SMB printing with Windows 98/Me

SMB printing (also known as Windows or WINS printing) allows 
you to print to a particular connection (Hold, Print, or Direct) 
without a network server PC. To set up SMB printing, you must 
have the TCP/IP protocol and Client for Microsoft Networks 
installed.

Note:This procedure should not be necessary if you installed the 
driver from the CD installer program. That program installs the 
Sharp LPR utility along with the driver and sets up the network 
connection for you.

Each connection (Hold, Print, or Direct) requires a new 
printer driver and printer description file. Repeat the procedure 
�To set up SMB printing on Windows 98/Me� for each connection. 
If you install more than one printer, give each a descriptive name 
during printer driver installation, such as Aero-Print or Aero-Hold, 
so you can easily identify printers.
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Before you begin

� Configure the Fiery for SMB printing in Run Setup > Network 
Setup > Service Setup  >  Windows Setup.

SMB printing is referred to as Windows Printing in Setup, on the 
Control Panel Map, and on the Configuration page.

To set up SMB printing on Windows 98/Me

1. Run the Sharp LPR utility on the Windows 98 PC.

This utility will have been installed along with the driver if you 
installed it from the Drivers CD (CD1). If not, you will first need to 
install it from the available utilities on that CD.

2. Choose Permote Print>Add Printer.

Choose the Printer Name of your Sharp AR-C360P from the list of 
installed drivers.

3. Enter the Sharp AR-C360P�s IP address and any comments you wish to 
add.

Note:You can also locate the printer using the Discover button.

If you are not able to locate your Sharp AR-C360P, contact your 
network administrator.
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4. Click OK.

Note:For a description of each print connection, see Chapter 3 of 
the Configuration Guide.
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Setting up IPP printing with Windows 98/Me

With Internet Printing Protocol (IPP), print jobs are sent to the 
Fiery over the Internet.

IPP printing is supported on Windows 2000/XP but can be enabled 
on Windows 98/Me computers by installing the wpnpins.exe client 
file (available on the Windows Me CD or the Windows 2000 Server 
CD). For more information about obtaining and installing this 
client, contact Microsoft Technical Support.

Note:The IPP setup procedures are performed after installing the 
appropriate printer drivers. See �To install the PostScript or PCL 
printer driver for Windows 98/Me� on page 1-17.

Before you begin

1. Prepare the Fiery for TCP/IP printing.

2. Make sure the Fiery is configured for IPP printing.

For more information, see the Configuration Guide.

3. Specify the printing destination on your computer.

To set up IPP printing with Windows 98/Me

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers windows, right-click the icon for the Fiery PostScript 
printer driver and choose Properties.

3. Click the Details tab and click Add Port.

The Add Port dialog box appears.

4. Enter the network path for the printer.

5. Click OK. 
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Setting up PostScript or PCL printing with 
Windows NT 4.0
To set up the Fiery as a PostScript or PCL printer, you must install 
the PostScript or PCL printer driver for Windows NT 4.0 and the 
corresponding printer description files. You must also configure 
the print connection between the computer and the Fiery. If you 
are printing over a network, you must configure a network 
connection. If you are printing directly to the printer, you must 
configure a parallel port connection.

Note:The procedures for setting up printing with the PostScript 
and PCL printer drivers are similar. The following illustrations show 
the PostScript driver. Any differences are noted.

Installing the PostScript or PCL printer driver 
for Windows NT 4.0
The procedure for installing the printer driver(s) for 
Windows NT 4.0 is similar to that for installing under Windows 98. 
If you follow that procedure, installing from the included Drivers 
CD (CD1), the LPR and Network Extension utilities are 
automatically included in the installation, and the network 
connection on TCP/IP networks is established automatically by the 
installer.

To install the PostScript or PCL printer driver 
for Windows NT 4.0

1. Insert CD1 into your CD drive and wait for the CD to autorun the setup 
program.

If the CD does not autorun navigate to the CD root directory and 
double-click the setup.exe program to start the installer.
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2. Choose your preferred language for the installer.

3. From the next screens after accepting the licensing agreement, follow the 
on-screen instructions to complete the driver installation.

4. Click Install Driver to begin installing the required printer driver and 
follow the on-screen instructions to complete the driver installation.

You can run this procedure twice if you want more than one driver 
installed. For example, if you want the EFI PostScript driver and 
the PCL driver run the procedure once for each driver and choose 
the required driver each time. Choose a name for the installed 
driver that will indicate which driver and printer it is for.

For networked printers the installer will also install the Sharp LPR 
program, which makes connecting the printer over TCP/IP 
networks easy, and the Network Extension, which enables the 
driver to query the printer and automatically enable any optional 
hardware installed on it.

For the Fiery PS driver the installer will also install the Job Monitor 
utility so that you can monitor the status of the printer and your 
print jobs directly from the Windows desktop.
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5. When driver installation is complete you may wish to install other 
software utilities from the main installer screen. Information about each 
is available on the installer screen.
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Configuring installed options
After you have completed the printer driver installation, you must 
configure the driver to reflect any optional hardware installed on 
the Sharp AR-C360P. This allows the driver to take advantage of 
these features. You can configure the options manually; or for 
TCP/IP network connections, you can use the Two-Way 
Communication feature to configure the options automatically.

Configuring installed options manually

The following procedure describes how to manually configure the 
driver for the options installed on the printer.

To configure installable options from the printer 
driver for Windows NT 4.0

1. Click Start>Settings>Printers.

2. Right-click the appropriate printer icon and choose Properties from the 
context menu.

3. Click the Installable Options (PS) or Device Options (PCL) tab.

4. Select an installed option from the Available Options list.

5. In the PS driver click Add to move the option to the Installed Options list. 
This is not necessary in the PCL driver.

6. Click Apply, and then click OK.

You are ready to connect to your network type (see �Completing 
the Windows NT 4.0 printer connection� on page 1-37).

Configuring installed options and updating print options 
settings automatically

If you have a TCP/IP-enabled network, you can automatically 
update your printer driver to reflect the options currently installed 
on the Sharp AR-C360P. When the printer driver is first installed, 
the installable options have default settings that were set up in 
Fiery Setup or ColorWise Pro Tools. When you update the printer 
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driver with the Two-Way Communication feature, you allow the 
Sharp AR-C360P to complete the actual setting.

The Two-Way Communication feature also updates Expert Color 
Settings options to reflect the current Color settings on the Fiery. 
To access Expert Color Settings options, click the Expert Settings 
tab in the ColorWise print option bar of the Fiery printing tab of 
your printer driver. For more information, see Chapter 1 of the 
Color Guide.

To set up Two-Way Communication in the printer 
driver for Windows NT 4.0

1. In the Installable Options (PS) or Device Options (PCL) tab, select Two-
Way Communication.

2. Type the Sharp AR-C360P�s IP address or DNS name.

3. In the PS driver, to display the Sharp AR-C360P�s current default settings 
when opened, select Update Fiery Driver When Opened.

4. Click Update.

5. In the PS driver, to receive an e-mail notification after your job has been 
printed, select Enable E-mail Notification, and type in the e-mail address 
to which notification should be sent.

You will also receive e-mail notification of any errors that occur 
during printing.

Note:Enable E-mail Notification is displayed only if Email Service 
is enabled at Setup.

6. Click OK.

Completing the Windows NT 4.0 printer 
connection
To print from Windows NT 4.0, you must:

� Set up network servers, if any.

� Set up the Fiery to accept print jobs from your computer.
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� Configure a port on each Windows NT 4.0 computer for the 
network type.

Completing the Windows NT 4.0 parallel port connection

The parallel port cable connects the Fiery to a single computer. 
Once you have installed the Windows NT 4.0 PostScript printer 
driver and the Fiery printer description files, complete the setup 
for parallel port printing.

To set up parallel printing for Windows NT 4.0

1. Click Start, choose Settings, and then choose Printers.

2. Double-click the Fiery icon and choose Properties from the Printer menu.

In the Ports tab, confirm that LPT1 (Local Port) is checked.

The Fiery is ready to accept parallel print jobs from your 
computer, using the Windows NT 4.0 PostScript printer driver and 
the Fiery printer description file.

3. Click the General tab and click Print Test Page.

4. To share the printer on the network, click the Sharing tab.

Select whether to share the printer, and specify the operating 
systems used by  
network clients.

To do this See

Configure the parallel 
connection

Required for printing locally via 
parallel port. See �Completing the 
Windows NT 4.0 parallel port 
connection� in this section.

Configure the TCP/IP (LPR port) 
connection

Done automatically during driver 
installation from CD.

Configure the IPX (Novell) 
connection

Required for printing via a NetWare 
server. See �Completing the 
Windows NT 4.0 IPX (Novell) 
connection� on page 1-39.
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5. Click OK to exit the Printer Properties dialog box.

Completing the Windows NT 4.0 IPX (Novell) connection

Complete the setup for the IPX (Novell) connection as follows:

� Configure the Novell network and file server for handling Fiery 
print jobs. The file server should be configured with a print 
server and print connection for the Fiery. For details, see your 
NetWare documentation.

� Prepare the Fiery for IPX printing.

� Set up the IPX connection on the computer.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and 
NetWare client services should already be installed on the 
Windows NT 4.0 computer.

To set up IPX (Novell) printing for Windows 
NT 4.0

1. Double-click Network Neighborhood.

2. Double-click NetWare or Compatible Network.

A list of NetWare servers appears.

3. Double-click the NetWare Tree or File Server on which the network 
administrator defined a print connection for the Fiery.
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You may have to log in to the file server to see the print 
connections.

4. Double-click the print connection defined for the Fiery.

5. If the NetWare server does not have a suitable driver for the Fiery, you 
may be asked if you want to set up the printer on your computer. Click 
Yes.

6. Insert the Drivers CD (CD1) and click OK to install the Fiery PostScript 
printer driver.

If the CD Installer window opens and prompts for your preferred 
language, simply close the window.

7. In the dialog box displaying lists of manufacturers and printers, click 
Have Disk.

The Install from Disk dialog prompts you for a disk.

8. Type the name of your CD driver (for example, D:\) and click Browse.

9. Browse to the \Drivers\<language>\nt40\PS (or PCL) folder and click 
Open.

The selected path is copied to the Install from Disk dialog.

10. In the Printers list, select the driver for your printer model and click OK.

When installation is complete, a new printer window appears, with 
the name of the print queue on the NetWare server.

11. Choose Properties from the File menu and click the Ports tab.

Verify that the connection to the NetWare queue is listed and 
selected as a port for the Fiery.
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12. Click the General tab and click Print Test Page.

13. In the printer Job Notes window, type user and job identification 
information and click OK.

The Test page remains listed in the queue window until it is 
printed.

The Fiery polls the NetWare server for print jobs in the print 
connection defined for the Fiery. When you print, your PostScript 
files are spooled to that connection and transmitted over the 
queue �port� to the Fiery.

Setting up SMB printing on Windows NT 4.0

SMB printing (also known as Windows printing) allows you to 
install the PostScript or PCL printer driver and printer description 
files, and print from your computer to a particular print connection 
(Hold, Print, or Direct) on the Fiery. These instructions assume 
you have installed the TCP/IP protocol and Client for 
Microsoft Networks.
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Each connection (Hold, Print, or Direct) requires a new printer 
driver and printer description file. To set up printing to a second or 
third print connection, repeat the procedure �To set up SMB 
printing on Windows NT 4.0� on page 1-42. If you install more 
than one printer, give each a descriptive name during printer 
driver installation, such as Aero-Print or Aero-Hold, so you can 
easily identify printers.

Note:To change printer defaults and configure installable options 
from Windows NT 4.0, you must log on with the special log-in 
name, �efi_admin_efi� (instead of Administrator) and use the 
password specified in Fiery Setup. If you log on as a User, you can 
install the printer driver through Point and Print, but you cannot 
modify printer defaults and configure installable options.

Before you begin

� Configure the Fiery for SMB printing in Run Setup > Network 
Setup > Service Setup >  Windows Setup.

SMB printing is referred to as Windows Printing in Setup, on the 
Control Panel Map, and on the Configuration page. For more 
information, see Chapter 2 of the Configuration Guide.

To set up SMB printing on Windows NT 4.0

1. Double-click Network Neighborhood.
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2. Browse for the printer you want to print to.

The printer name you are browsing for is the name entered in 
Network Setup > Service Setup > Windows Setup > Server Name. 
For this information, see the Configuration page.

The amount of network traffic determines the amount of time 
required for the Browse function.

Note:You can also locate the printer with the Find feature on your 
Windows computer. Click Start , choose Find, and then choose  
Computer. Enter the name of the printer, and click Find Now.

If you are not able to locate your Sharp AR-C360P, contact your 
network administrator.

3. Double-click the name of the Fiery to display enabled print connections.

4. Double-click the name of the connection you want to print to.

The Printers dialog box appears, asking whether you want to set 
up the printer.

5. Select Yes to complete the installation for the selected connection.

Windows NT 4.0 downloads the printer driver and printer 
description files from the Fiery to your computer and installation is 
complete.
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Setting up PostScript or PCL printing with 
Windows 2000/XP/Server 2003
To set up the Fiery as a PostScript or PCL printer, you must install 
the PostScript or PCL printer driver for Windows 2000/XP/Server 
2003 and the corresponding printer description files. You must 
also configure the print connection between the computer and the 
Fiery. If you are printing over a network, you must configure a 
network connection. If you are printing directly to the printer, you 
must configure a parallel port connection.

Note:For Windows Server 2003, use the Windows XP printer 
driver.

Note:The procedures for configuring the options for the PostScript 
and PCL printer drivers are similar.

Installing the PostScript or PCL printer driver 
for Windows 2000/XP/Server 2003
The following procedure describes installing the printer driver 
from the Drivers CD (CD1). Subsequent procedures describe 
setting up the print connection.

To install the PostScript or PCL printer driver  
for Windows 2000/XP/Server 2003

1. Insert CD1 into your CD drive and wait for the CD to autorun the setup 
program.

If the CD does not autorun navigate to the CD root directory and 
double-click the setup.exe program to start the installer.
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2. Choose your preferred language for the installer.

3. From the next screens after accepting the licensing agreement, follow the 
on-screen instructions to complete the driver installation.

4. Click Install Driver to begin installing the required printer driver and 
follow the on-screen instructions to complete the driver installation.

You can run this procedure twice if you want more than one driver 
installed. For example, if you want the EFI PostScript driver and 
the PCL driver run the procedure once for each driver and choose 
the required driver each time. Choose a name for the installed 
driver that will indicate which driver and printer it is for.

For networked printers the installer will also install the Sharp LPR 
program which makes connecting the printer over TCP/IP 
networks easy.

The installer will also install the Network Extension, which enables 
the driver to query the printer and automatically enable any 
optional hardware installed on it.
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For the Fiery PS driver the installer will also install the Job Monitor 
utility so that you can monitor the status of the printer and your 
print jobs directly from the Windows desktop.

5. When driver installation is complete you may wish to install other 
software utilities from the main installer screen. Information about each 
is available on the installer screen. 
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Configuring installed options
After you have completed the printer driver installation, you must 
configure the Fiery to reflect the options installed on the printer. 
This allows the Fiery to take advantage of these options. You can 
configure the options manually; or for TCP/IP network 
connections, you can use the Two-Way Communication feature to 
configure the options automatically.

Configuring installed options manually

The following procedure describes how to manually configure the 
Fiery for the options installed on the printer.

To configure installable options on the Fiery from 
the PostScript printer driver for Windows 
2000/XP/Server 2003

1. Windows 2000: Click Start, choose Settings, and then choose Printers. 

Windows XP: Click Start, and choose Printers and Faxes.

Windows Server 2003: Click Start, choose Control Panel, and then choose 
Printers and Faxes.

2. Right-click the appropriate printer icon and choose Properties.

3. Click the Installable Options (PS) or Device Options (PCL) tab.

4. Select an installed option from the Available Options list.

5. In the PS driver click Add to move the option to the Installed Options list. 
This is not necessary in the PCL driver.

6. Click OK to activate the current settings.

You are ready to connect to your network type (see the next 
section �Completing the Windows 2000/XP/Server 2003 
printer connection�).

Configuring installed options and updating print options 
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settings automatically

If you have a TCP/IP-enabled network, you can automatically 
update your printer driver to reflect the options currently installed 
on the Fiery. When the printer driver is first installed, the 
installable options have default settings that were set up in 
Fiery Setup or ColorWise Pro Tools. When you update the printer 
driver with the Two-Way Communication feature, you allow the 
Fiery to complete the actual setting.

The Two-Way Communication feature also updates Expert Color 
Settings options to reflect the current Color settings on the Fiery. 
To access the Expert Color Settings options, click the Expert 
Settings tab in the ColorWise print option bar of the Fiery printing 
tab of your printer driver. For more information, see Chapter 1 of 
the 
Color Guide.

To set up Two-Way Communication for PostScript 
or PCL printer drivers for Windows 
2000/XP/Server 2003

1. In the Installable Options (PS) or Device Options (PCL) tab, select Two-
Way Communication.

2. Type the Sharp AR-C360P�s IP address or DNS name.

3. In the PS driver, to display the Sharp AR-C360P�s current default settings 
when opened, select Update Fiery Driver When Opened.

4. Click Update.

5. In the PS driver, to receive an e-mail notification after your job has been 
printed, select Enable E-mail Notification, and type in the e-mail address 
to which notification should be sent.

You will also receive e-mail notification of any errors that occur 
during printing.

Note:Enable E-mail Notification is displayed only if Email Service 
is enabled at Setup.
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6. Click OK.

Completing the Windows 2000/XP/Server 2003 
printer connection
To print from Windows 2000/XP/Server 2003, you must:

� Set up network servers, if any.

� Set up the Fiery to accept print jobs from your computer.

� Configure a port on each Windows 2000/XP/Server 2003 
computer for the network type.

Note:The procedures for completing the printer connection for 
Windows 2000/XP and Windows Server 2003 are similar. 
Windows 2000 illustrations are used in the following procedure, 
with relevant Windows XP differences noted.

To do this See

Configure the parallel 
connection

�Completing the Windows 
2000/XP/Server 2003 parallel port 
connection� in this section.

Configure the TCP/IP (LPR port) 
connection

�Completing the Windows 
2000/XP/Server 2003 TCP/IP and 
Port 9100 or LPR connection� on 
page 1-51. 

Configure the IPX (Novell) 
connection

�Completing the Windows 
2000/XP/Server 2003 IPX (Novell) 
connection� on page 1-52.
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Completing the Windows 2000/XP/Server 2003 parallel 
port connection

The parallel port cable connects the Fiery to a single computer. 
Once you have installed the Windows 2000/XP/Server 2003 
PostScript printer driver and the Fiery printer description files, 
complete the setup for parallel port printing.

To set up parallel printing for Windows 
2000/XP/Server 2003

1. Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start, and choose Printers and Faxes. 
Windows Server 2003: Click Start, choose Control Panel, and then choose 
Printers and Faxes.

2. Double-click the Fiery icon and choose Properties from the Printer menu.

In the Ports tab, confirm that LPT1 (Local Port) is selected.

The Fiery is ready to accept parallel print jobs from your 
computer, using the Windows 2000/XP/Server 2003 PostScript 
printer driver and the Fiery printer description file.

3. Click the General tab and click Print Test Page.

4. To share the printer on the network, click the Sharing tab.

Select whether to share the printer, and specify the operating 
systems used by  
network clients.

5. Click OK to exit the Printer Properties dialog box.
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Completing the Windows 2000/XP/Server 2003 TCP/IP 
and Port 9100 or LPR connection

Note:If you installed the driver from the Drivers CD (CD1), this 
procedure is not necessary. TCP/IP connection will have been set 
up automatically during the installation.

Once you have installed the PostScript and printer driver files, 
complete the setup for the TCP/IP and LPR connection as follows:

� Prepare the Fiery to accept print jobs using TCP/IP and LPR 
protocols. For details, see Chapter 2 of the Configuration Guide.

� Install Sharp LPR software utility from the Drivers CD (CD1).

� Run Sharp LPR and add the printer by discovery on the network. 
(See the Help screens with the Sharp LPR utility.)

Before you continue, contact the system administrator for the IP 
address assigned to the Fiery, as well as the subnet mask and the 
gateway address, if they are used.

The TCP/IP protocol should already be installed on the Windows 
2000/XP/Server 2003 workstation.

Note:You can also set up the LPR connection by installing Print 
Services for UNIX, which is supplied as an add-on Windows 
component with your Windows 2000/XP/Server 2003 CD. For 
more information, see your Windows documentation.

To set up TCP/IP and Port 9100 or LPR connection 
for Windows 2000/XP/Server 2003

1. Insert the Drivers CD (CD1) and wait for the CD Installer to autorun.

If the setup program does not start after a minute or so, navigate 
to the CD top level directory and run setup.exe.

2. Choose you preferred installer language and wait for main installer screen 
to appear. If necessary, click Accept when prompted to accept the licence 
conditions.
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3. Follow the directions of the main installer screen to install Sharp LPR and 
then the Sharp Network Extension from the available software utilities.

4. When installation if complete, exit the CD Installer program. 

5. Reboot the computer and then run Sharp LPR either from the Programs 
menu or from its icon in the system tray (bottom right, near the clock).

6. Choose Add Printer from the Remote Print menu (see Sharp LPR on-line 
help).

7. Choose your Sharp AR-C360P installed driver from the Printer Name 
drop-down list.

8. Enter the IP address of the Sharp AR-C360P if you have it, or click the 
Discover button to search the network and choose your printer.

If your printer is connected via DHCP the Sharp LPR utility will still 
find it if its IP address changes next time it is rebooted.

Completing the Windows 2000/XP/Server 2003 IPX 
(Novell) connection

Complete the setup for the IPX (Novell) connection as follows:

� Configure the Novell network and file server for handling Fiery 
print jobs. The file server should be configured with a print 
server and print connection for the Fiery. For details, see your 
NetWare documentation.

� Prepare the Fiery for IPX printing.

� Set up the IPX connection on the computer.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and 
NetWare client services should already be installed on the 
Windows 2000/XP/Server 2003 computer.
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To set up IPX (Novell) printing for Windows 
2000/XP/Server 2003

1. Windows 2000: Double-click My Network Places. 
Windows XP: Click Start, and then click My Network Places. 
Windows Server 2003: Click Start, choose Explorer, and then click My 
Network Places.

2. Double-click NetWare or Compatible Network.

A list of NetWare servers appears.

3. Double-click the NetWare Tree or File Server on which the network 
administrator defined a print connection for the Fiery.

You may have to log in to the file server to see the print 
connections.

4. Double-click the print connection defined for the Fiery.

5. If the NetWare server does not have a suitable driver for the Fiery, you 
may be asked if you want to set up the printer on your computer. Click 
Yes.

6. Click OK to install the Fiery PostScript printer driver.

7. Follow the procedure that starts with step 6 on page 1-17.

When installation is complete, a new printer window appears, with 
the name of the print queue on the NetWare server.

8. Choose Properties from the File menu and click the Ports tab.
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Verify that the connection to the NetWare queue is listed and 
selected as a port for the Fiery.

9. Click the General tab and click Print Test Page.

10. In the printer Job Notes field, type user and job identification information 
and  
click OK.

The Test page remains listed in the queue window until it is 
printed.

The Fiery polls the NetWare server for print jobs in the print 
connection defined for the Fiery. When you print, your PostScript 
files are spooled to that connection and transmitted over the 
queue �port� to the Fiery.

Setting up SMB printing on Windows 2000/XP/Server 2003

SMB printing (also known as Windows printing) allows you to 
install the printer driver and associated files, and print from your 
computer to a particular print connection (Hold, Print, or Direct) 
on the Fiery. These instructions assume you have installed the 
TCP/IP protocol and Client for Microsoft Networks.
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Each connection (Hold, Print, or Direct) requires a new printer 
driver and printer description file. To set up printing to a second or 
third print connection, repeat the procedure, �To set up SMB 
printing on Windows 2000/XP/Server 2003�. If you install more 
than one printer, give each a descriptive name during printer 
driver installation, such as Aero-Print or Aero-Hold, so you can 
easily identify printers.

Before you begin

� Configure the Fiery for SMB printing in Network Setup > Service 
Setup > Windows Setup.

SMB printing is referred to as Windows Printing in Setup, on the 
Control Panel Map, and on the Configuration page. For more 
information, see Chapter 2 of the Configuration Guide.

To set up SMB printing on Windows 
2000/XP/Server 2003

1. Open My Network Places.

2. Browse for the printer you want to print to.

The printer name you are browsing for is the name entered in 
Network Setup > Service Setup > Windows Setup  >  Server Name. 
For this information, see the Configuration page.

The amount of network traffic determines the amount of time 
required for the Browse function.

Note:You can also locate the printer using the Search feature on 
your Windows computer. Right-click My Network Places and click 
Search for Computers. Type the name of the printer and click 
Search Now.

If you are not able to locate your Fiery, contact your network 
administrator.

3. Double-click the name of the Fiery to display enabled print connections.

4. Double-click the print connection you want to print to.
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The printer files are downloaded from the Fiery and the print 
connection is set up.

For more information, see �To install the PostScript or PCL printer 
driver for Windows 2000/XP/Server 2003� on page 1-44.
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Setting up IPP printing with Windows 2000/XP/Server 
2003

With Internet Printing Protocol (IPP), print jobs are sent to the 
Fiery over the Internet.

IPP printing is supported directly for Windows 2000/XP/Server 
2003 computers. IPP printing is not supported on Windows 
NT 4.0.

Note:The IPP setup procedures are performed after installing the 
appropriate printer drivers (see �To install the PostScript or PCL 
printer driver for Windows 2000/XP/Server 2003� on page 1-44).

Before you begin

1. Prepare the Fiery for TCP/IP printing.

2. Make sure the Fiery is configured for IPP printing. For more information, 
see Chapter 4 of the Configuration Guide.

3. Specify the printing destination on your computer.

To set up IPP printing with Windows 
2000/XP/Server 2003

1. Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes. 
Windows Server 2003: Click Start, choose Control Panel, and then choose 
Printers and Faxes.

2. Windows 2000: Double-click the Add Printer icon and click Next. 
Windows XP: Click Add Printer. 
Windows Server 2003: Choose Add a printer

3. Select Network printer and click Next.
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4. Select �Connect to a printer on the Internet or on your intranet.� Type an 
IP address or computer name in the URL field.

The URL for the printer is the IP address or DNS name followed by 
�ipp� and the connection you want to print to (print, hold, or 
direct). Insert slashes between the different elements.

5. Click Next.

The Connect to Printer dialog box appears.

6. Click OK.

The Add Printer Wizard dialog box appears. 

7. If you are installing the PostScript printer for Windows 2000/XP/Server 
2003 for the first time, follow the procedure described on page 1-44.

If you have already installed the printer driver on your computer, 
choose the appropriate names from the Manufacturers and 
Printers lists and click OK.

8. Indicate whether you want to make the Fiery the default printer and 
click Next.

9. Click Finish.
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Installing EFI Fiery Mail Port
The E-Mail Service provides a method to print and control the 
Sharp AR-C360P remotely. Jobs are sent to the Sharp AR-C360P 
in the form of e-mail attachments. You can set up e-mail printing 
on Windows computers by adding the EFI Fiery Mail Port software 
as a printer port.

To set up the Fiery for e-mail printing, see Chapter 4 of the 
Configuration Guide. After Setup has been performed, install the 
software from the Utilities CD (CD2) onto your Windows 
computer, and then add a port.

Note:Procedures are given for Windows 98/Me and 
Windows NT 4.0. Procedures for Windows 2000/XP/Server 2003 
are similar to those for Windows NT 4.0.

To install the e-mail port monitor on Windows 
computers

1. Insert the Utilities CD (CD2) supplied with your Sharp AR-C360P into your 
CD drive.

Normally the Installer program should autorun. If it does not, 
navigate to the top level directory window of the CD and run 
setup.exe.

2. Select Fiery Utilities.

3. Click on Install Fiery Mail Port and follow the on-screen prompts to install 
the mail port to your computer.

When installation is complete, you are ready to configure the 
connection for the e-mail port monitor.

To configure the connection for EFI Fiery Mail Port 
on Windows 98/Me

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers window, right-click the icon for the Fiery printer driver.
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For instructions on installing the printer driver, see �Installing the 
PostScript or PCL printer driver for Windows 98/Me� on 
page 1-17.

3. Choose Properties, and click the Details tab.

4. Click Add Port.

5. Click Other and select EFI Fiery Mail from the list of ports.

6. Click OK.

7. Enter the basic information required to set up the e-mail port. 

Fiery�s E-mail Address�Enter the e-mail address of the Sharp AR-
C360P.

Outgoing Mail Server�Enter the name or IP address of the SMTP 
server for the port monitor to use.

8. Click Advanced.
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The E-Mail Port Configuration dialog box appears.

9. Enter the following information.

For Fiery Server:

E-mail Address�The e-mail address of the Sharp AR-C360P.

Queue�The print connection on the Fiery that you want.

For Outgoing Mail Server (SMTP):

Server Name�The SMTP server to use.

From Address�The �from� address to insert in the e-mail.

For Options:

Break apart messages larger than�The maximum size of a single 
e-mail message is displayed. If a job exceeds this size, it is split 
into multiple messages, each not exceeding this size.

Status messages from Fiery�When enabled, the Status option 
requests the Fiery to send status reports of the job via e-mail.

10. Click OK.

The name assigned to the EFI Fiery Mail Port appears in the 
Details tab of the Fiery printer driver.

11. Click Apply, and then click OK.
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The connection for the EFI Fiery Mail Port has now been 
configured.

To configure the connection for the EFI Fiery Mail 
port on Windows NT 4.0

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers window, double-click the Add Printer icon and click Next.

3. Specify printing using a Local printer and click Next.

4. In the window displaying a list of ports, click Add Port.

The Printer Ports dialog box is displayed, with the EFI Fiery Mail 
port listed as one of the available ports.

5. Select EFI Fiery Mail and click New Port.

The Add Port dialog box appears.

6. Enter the basic information required to set up the e-mail port.
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Fiery�s E-mail Address�Enter the e-mail address of the Sharp AR-
C360P.

Outgoing Mail Server�Enter the name or IP address of the SMTP 
server for the port monitor to use.

7. Click Advanced.

The E-Mail Port Configuration dialog box appears.

8. Enter the following information.

For Fiery Server:

E-mail Address�The e-mail address of the Fiery.

Queue�The print connection on the Fiery that you want.

For Outgoing Mail Server (SMTP):

Server Name�The SMTP server to use.

From Address�The �from� address to insert in the e-mail.

For Options:

Break apart messages larger than�The maximum size of a single 
e-mail message is displayed. If a job exceeds this size, it is split 
into multiple messages, each not exceeding this size.

Status messages from Fiery�When enabled, the Status option 
requests the Fiery to send status reports of the job via e-mail.
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9. Click OK.

The Add Printer Wizard dialog box appears.

10. Click Next and follow the instructions for installing the printer driver for 
your Windows computer.
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Installing Fiery utilities
From the CD2, you can install the following Fiery utilities and 
user software:

� ColorWise Pro Tools

� Fiery Downloader

� EFI Fiery Mail Port (see �Installing EFI Fiery Mail Port� on 
page 1-59)

� Command WorkStation

� Fiery Remote Scan

The Fiery utilities must be separately installed on each user�s 
computer. The installation of each utility is similar. Before you 
begin each installation, determine where you want to install each 
item on your hard disk. Otherwise, the software is placed by 
default in the Fiery folder inside the Programs folder. The 
Command WorkStation installer also installs the Java files 
necessary to use Fiery Setup from Command WorkStation.

Note:To install software, you must have Service Pack 4 installed 
on a Windows 2000 computer and Service Pack 1 installed on 
Windows XP. If not, a warning message alerts you to install the 
correct service pack.

To use Fiery software (Command WorkStation and ColorWise Pro 
Tools) as well as WebTools on a Windows computer, you must 
install the Sun Java file, Java Runtime Environment (JRE), 
provided in the CommonUtl folder on the User Software CD. If the 
Sun Java file is not installed, you are prompted to install it before 
you proceed to install Fiery software. For more information on 
installing Java Runtime Environment (JRE), see �To install Sun 
Java on your computer� on page 1-66. For more information on 
WebTools, see the Job Management Guide and the Printing Guide.



11-66 Installing User Software on a Windows Computer

Sharp AR-C360P EFI User�s Software Installation Guide - 66

To install Sun Java on your computer

1. When the dialog box prompting you to install Java Runtime Environment 
(JRE) appears, click OK to proceed with installation.

2. Click Yes in the License Agreement dialog box.

3. Select Typical for Setup Type and click Next.

4. When installation of Java Runtime Environment (JRE) files is complete, 
click Finish and follow the instructions for installing Fiery software in �To 
install Fiery utilities� on page 1-67.

After installation of the Sun Java files, a Java Web Start shortcut is 
created on your computer desktop. This is not intended for use 
with Fiery software, so you may delete the shortcut if you wish.
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To install Fiery utilities

1. Insert the Utilities CD (CD2) supplied with your Sharp AR-C360P into your 
CD drive.

Normally the Installer program should autorun. If it does not, 
navigate to the top level directory window of the CD and run 
setup.exe.

2. Select Fiery Utilities.

3. Click on the name of the utility you wish to install.

Click on the �Tell me more� links to see a description of each 
utility.

4. Follow the instructions in the Setup dialog boxes to complete installation.
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Using Fiery utilities for the first time
Before you can use the newly installed software, you must 
configure the connection to the Fiery.

Configuring the connection for Fiery utilities
The first time you start one of the Fiery utilities, you must 
configure the connection to the Fiery. Similar configuration is used 
for all Fiery utilities, so a change in one configuration affects all 
the other connections. Configuration for most Fiery utilities is 
described in the following procedure.

For configuration of specific Fiery utilities, see �Configuring the 
connection for Command WorkStation� on page 1-70.

Before you begin

� Print the Configuration page from the Sharp AR-C360P Control Panel.

This page contains information you need when configuring the 
connection, such as the IP address. For TCP/IP installations, you 
can use the DNS name of the Fiery instead of the IP address. 
Make sure the Fiery is already registered in a Domain Name 
Server (DNS) on your network. For more information, see your 
Windows system documentation.

To configure the connection for Fiery utilities

1. Start the utility for which you want to configure a connection.

For details, see the Printing Guide.

2. If the No Servers Configured dialog box appears, click OK.

If the Choose Printer Device dialog box appears, click Add.

3. Enter the appropriate information for the Fiery.

Nickname�Enter a name for the Fiery. This name does not have 
to match the actual Server Name of the Fiery.
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Note:The nickname cannot contain any of the following seven 
characters: 
[ ] _ " ' <space> <tab>

Protocol�Choose the type of network protocol you are using from 
the menu.

Note:Fiery utilities are not supported over IPX/SPX. Command 
WorkStation is supported on Windows computers over TCP/IP.

Server Name�Enter the IP address (or DNS name) of the Sharp 
AR-C360P.

New Device�Enter the name of the device the Fiery is installed 
in:  Sharp AR-C360P.

Note:Type Sharp AR-C360P exactly as shown because the device 
name is case-sensitive.

4. When you have entered all the information, click Add.

5. With the device name (Sharp AR-C360P) selected in the Devices list, click 
OK.

The Fiery appears in the list of available servers. The first line of 
the entry displays the nickname you gave the server, followed by 
the protocol you chose. The second line displays the device name.

6. With the device name selected in the list of Available Servers, click Select 
to begin using the utility.

Device name of the  
Fiery (Sharp AR-C360P)
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Modifying the configuration

Edit the configuration whenever there is any change to your Fiery 
server or network, such as a server name or IP address. If you 
change Fiery Setup information, do so before reconfiguring the 
connection.

To modify the configuration

1. To edit information for a Fiery in the list of available servers, select the 
Fiery by its nickname and click Modify.

2. Make the necessary changes in the Modify Server Settings dialog box and 
click OK.

3. To add a new Fiery to the list of available servers, click Add. Configure the 
Add New Server dialog box as outlined in steps 3 through 5 in the 
previous procedure.

4. To remove a Fiery, select the Fiery by its nickname and click Remove.

Note:The nickname cannot be modified.

Configuring the connection for Command 
WorkStation
The first time you start Command WorkStation, you are prompted 
to configure the connection to the Fiery.

To configure the connection for Command 
WorkStation

1. Print a Configuration page.

The information on this page helps you locate the Fiery, if it is not 
on the same local subnet as your computer.

2. Start Command WorkStation.

The Available Servers dialog box appears. All servers found in the 
local subnet are displayed.
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3. If no Fiery servers were found, click the Manual tab to search by DNS 
name 
or IP address. Click Add to add the server to the Available Servers list.

4. Click the Auto Search tab and then click Advanced to search by either a 
range of IP addresses or the IP address and subnet mask.
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5. Click Search.

All available servers appear in the Available Servers list.

6. Select the Fiery server you want to use and click Add.

The selected Fiery server appears in the Login Server dialog box.

7. Click the server name.
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The Log In dialog box appears.

8. Select Administrator, Operator, or Guest and click Log In.

Your computer is connected to the server.

Modifying the configuration

Edit the configuration whenever there is any change to your Fiery 
server or network, such as a server name or IP address. If you 
change Fiery Setup information, do so before reconfiguring the 
connection.

To modify the configuration

1. Start Command WorkStation.

The Login Server window appears.

2. Select the Fiery server for which you want to modify the configuration,  
and click Remove.

The Available Servers dialog box appears.

3. To add the modified Fiery server, follows steps 3 through 6 of the 
procedure, 
�To configure the connection for Command WorkStation� on page 1-70.
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To modify the connection to the Fiery, you must remove the 
server from the Login Server list and follow the procedure for 
configuring the connection.
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Installing Color files from the 
User Software CD
You can copy additional Color files from the User Software CD to 
your hard disk. Many of the files are PostScript files that you can 
download and print using Fiery Downloader.

ICC folder ICC monitor settings file and a device profile specially 
designed for use with the Fiery and particular printer 
models. For instructions on installing, see �Installing 
the ICC profiles on a Windows computer� on 
page 1-76.

Clrfiles folder 
(inside the 
English 
folder)

Cmyk.ps, an 11-page, letter-size PostScript file to use 
for reference when defining CMYK Colors in 
applications.

Pantone.ps, a 19-page, letter-size PostScript file that 
indicates the closest equivalent of PANTONE coated 
Colors that the Fiery and your Sharp AR-C360P can 
produce. The method used to print the Pantone.ps file 
differs depending on the Spot Color Matching setting. 
For more information, see the Printing Guide and the 
Color Guide.

Rgb_01.doc, a file you can print from Microsoft Word 
97 or later to view available RGB Colors.

Rgb_02.ppt, a file you can print from PowerPoint 6.0 or 
later to view available RGB Colors.

Calibrat 
folder 
(inside the 
English\Clrfil
es folder)

Four PostScript files of Color patches for obtaining 
measurements: Custom21.ps, Custom34.ps, 
Stand21.ps, and Stand34.ps. The numbers in the file 
names refer to the number of patches on the page. The 
Custom files allow you to download measurement 
patches that incorporate the printer�s current 
calibration set. The Standard files allow you to 
download standard measurement patches that bypass 
the printer�s current calibration set. For information on 
using these files, see the 
Color Guide.

Note: These files are provided for expert users and 
should not be used for day-to-day calibration.
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Installing the ICC profiles on a Windows 
computer
The ICC profiles included in the Icm folder on CD2 are for use 
with ColorWise Pro Tools. You can also use the ICC profiles with 
applications that support ICC standards, such as Photoshop. For 
most ICC-aware applications, the files must be installed in a folder 
named Color in the System folder. For use with ColorWise Pro 
Tools, you can copy the files to a folder of your choice.

You can upload additional ICC profiles with the Profile Manager in 
ColorWise ProTools. For more information on uploading and using 
ICC profiles with ColorWise Pro Tools, see Chapter 1 of the 
Color Guide.

To install the ICC profiles on a Windows computer

1. On CD2, open the ICC folder.

To access this folder click Start>Run, and enter D:\ICC (where D: 
is the drive letter of your CD drive). If the Installer autoruns when 
you load the CD, click Exit to close it.

2. If you are using Windows 98/Me, copy the profiles to the 
Windows\System\Color folder on your hard disk.

If you are using Windows NT or Windows 2000, copy the profiles to the 
Winnt\System32\Color folder on your hard disk.

Note:If a folder named �Color� does not exist in the System32 
folder, create one and install the profiles into it.

If you are using Windows XP/Server 2003, right-click the profile you want 
and click Install Profile.

Note:The profiles are installed automatically to the 
Windows\System32\spool\ drivers\color folder on your hard disk.

Loading the monitor settings file
The Efirgb.icm monitor settings file can be used in Photoshop, or 
other applications that support ICC profiles, to define a source 
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Color space for printing to the Sharp AR-C360P.

These instructions assume you have installed the ICC profiles 
included on CD2. For more information, see the preceding section.

Note:The internal name of an ICC profile may vary slightly from 
its file name.

To load the RGB Working Space profile for 
Photoshop 5.x

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose RGB Setup from 
the Color Settings submenu.

3. In the RGB Setup dialog box, click Load.

4. For Windows 98/Me, browse to the Windows\System\Color folder, select 
Efirgb.icc, and then click Load.



11-78 Installing User Software on a Windows Computer

Sharp AR-C360P EFI User�s Software Installation Guide - 78

For Windows NT 4.0 or Windows 2000, browse to the 
Winnt\System32\Color folder, select Efirgb.icc, and then click Load.

For Windows XP/Server 2003, browse to the Win-
dows\System32\spool\driver\color folder, select Efirgb.icc, and then click 
Load.

The Efirgb v1f file is displayed in the RGB menu of the RGB Setup 
dialog box.

5. Click OK.

For more information about ICC profiles, see your Photoshop 
documentation.

Loading the ICC printer device profile
This ICC profile defines the target Color space for printing to the 
printer.

These instructions assume you have installed the ICC profiles 
included on CD2. For more information, see �Installing the ICC 
profiles on a Windows computer� on page 1-76.

Note:The internal name of an ICC profile may vary slightly from 
its file name.

To load the ICC printer device profile in 
Photoshop 5.x

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose CMYK Setup from 
the Color Settings submenu.

3. In the CMYK Setup dialog box, choose ICC as the CMYK color model.

4. Select the profile that corresponds to the Fiery from the Profile menu.
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5. Click OK.

For more information about ICC profiles, see your Photoshop 
documentation.

Loading monitor settings files and ICC device profiles in 
Photoshop 6.x

Once you have installed the Efirgb.icc monitor settings file and the 
ICC device profile for the Fiery, they can be loaded at the same 
time in Photoshop 6.x.

To load the monitor settings file and ICM device 
profile in Photoshop 6.x

1. Start Photoshop.

2. Choose Color Settings from the Edit menu and select Advanced Mode in 
the Color Settings dialog box.

3. Choose EFI RGB from the RGB menu.

4. Choose the profile that corresponds to the Fiery from the CMYK menu.
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Installing the printer description files for 
Windows
The User Software CD contains printer description files for popular 
Windows applications. Adobe Pagemaker 5.0, 6.x, and 7.0 do not 
support automatic installation of printer description files from the 
Printers or Printers and Faxes Control Panel. To make the Fiery 
available in the Print and Page Setup dialog boxes of this 
application, copy printer description files to the appropriate 
location.

To copy the printer description files

1. On the User Software CD, open the English\Prntdrvr\Ps_drvr folder. 
Select the folder that corresponds to the system you are using.

For Windows 98/Me, select \Drivers\<language>\Win9x\ps.

For Windows NT 4.0, select \Drivers\<language>\nt4\ps.

For Windows 2000/XP/Server 2003, select 
\Drivers\<language>\Win2k_xp\ps.

2. Copy the printer description file �EF8X3324.PPD� to the appropriate 
location.

If you use To this location

PageMaker 5.0 \ALDUS\USENGLSH\PPD4

PageMaker 6.0 \PM6\RSRC\USENGLSH\PPD4

For PageMaker 
6.5

\PM65\RSRC\USENGLSH\PPD4

For PageMaker 
7.0

\PM7\RSRC\USENGLSH\PPD4
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The general steps for installing the Fiery user software and setting 
up printing on a Mac OS computer are as follows:

� Install the PostScript printer driver and printer description file.

� Set up the Sharp AR-C360P in the Chooser (Mac OS 9 or Mac OS 
X Classic mode) or in the Print Center (Mac OS X Native mode).

Note:The �Print Center� is called �Printer Setup Utility� in 
OS X 10.3 and above.

� Install the Fiery utilities (Fiery Remote Scan, ColorWise Pro 
Tools, Fiery Downloader, Command WorkStation LE, and 
Fiery Spooler).

� Configure the connection for Fiery utilities.

� Install the printer and screen fonts.

� Install the ColorSync profiles.

� Install additional color reference and application-specific files.

Setting up the Sharp AR-C360P as a PostScript 
printer
To set up the Sharp AR-C360P as a PostScript printer, you must 
install the PostScript printer driver and the printer description file 
that corresponds to your printer. The PostScript printer driver and 
printer description files are provided on the Driver CD (CD1). 
Printer drivers provide a way to communicate information on print 
jobs between your applications, the Sharp AR-C360P, and any 
other PostScript printer connected to your computer.

Setting up Mac printer drivers and printer 
description files
Detailed instructions for Mac OS 9 are provided on CD1 in the 
Mac OS 9:<language> folder.

Chapter 2:
Installing 
User Software 
on a Mac OS 
Computer
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Detailed instructions for Mac OS X are provided on CD1 in the 
Mac OS X folder.

Installing Fiery software and fonts
The Mac OS installers function essentially the same for each type 
of software. Before you begin each installation, determine where 
you want to install each item on your hard disk. Otherwise, the 
software is placed by default as follows:

� ColorSync profiles�ColorSync Profiles folder

For ColorSync 2.5, copy the profiles from the Extras:ColorSync 
Profiles folder on CD2 into the ColorSync Profiles folder inside 
your System folder.

� Fiery Spooler, Fiery Downloader, Command WorkStation LE, and 
ColorWise Pro Tools��Fiery� folder

� Fonts�System folder : Fonts folder

Mac fonts corresponding to those resident on the Sharp AR-
C360P are provided on CD1 in the Extras:Fonts:OS 9 and 
Extras:Fonts:OS X folders. These can be installed on your Mac 
for use in applications.

To install Mac OS software

1. Insert the Utilities CD (CD2) in the CD drive and double-click the Installer 
icon of the item you want to install, and then follow the instructions in the 
installer dialog boxes.

2. If prompted, click Quit to close the software installer.

In order to use ColorWise Pro Tools, Fiery Link, or Fiery Spooler, 
you must have Mac OS Runtime for Java (MRJ) installed on your 
computer.

If you do not have the appropriate MRJ installed, the installer 
automatically initiates the MRJ installation process.
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The respective installer prompts the MRJ installation from the CD. 
MRJ 2.2.5 is provided on the Utilities CD (CD2). We recommend 
that you use the version of MRJ provided on the Utilities CD with 
the Fiery software.

If you have a newer version of MRJ (such as 2.2.6) already 
installed on your computer and experience some difficulty using 
the Fiery software, either remove or relocate the MRJ files 
currently installed and reinstall the version of MRJ provided on 
CD2. Use the following procedure to uninstall MRJ.

To uninstall Mac OS Runtime for Java

1. Locate the System Folder on your hard disk.

2. Inside the Extensions folder, locate MRJ Libraries and remove it or move it 
to another folder.

Note:If you find the �MRJ Enabler� file under Extensions, remove 
it or move it to another folder.

3. Inside the Apple Extras folder, locate Mac OS Runtime for Java, and 
remove it or move it to another folder.

4. Restart your computer.
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Configuring a connection for ColorWise Pro Tools

The first time you use ColorWise Pro Tools, you are prompted to 
configure a connection to the Sharp AR-C360P.

Note:ColorWise Pro Tools are supported only over TCP/IP 
networks.

Before you begin

� Print the Configuration page from the Printer Control Panel and 
note the IP address of the Sharp AR-C360P.

Press the MENU keys until the Print Pages menu is displayed, then 
press ENTER to select this menu.

Press the MENU keys until CONFIGURATION is displayed, then 
press ENTER to print these pages.

The printer�s IP address is shown under Network Setup on the first 
configuration page.

To configure a connection for ColorWise Pro Tools

1. Start the utility by double-clicking its icon.

The Choose Printer Device dialog box appears.

2. If you have previously configured a connection to the Sharp AR-C360P, 
you are ready to use ColorWise Pro Tools. If you have not configured a 
connection, click Add.
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3. Enter the appropriate information for the Sharp AR-C360P.

Nickname�Enter a name for the Sharp AR-C360P. It does not 
have to match the actual server name of the Sharp AR-C360P.

Note:The nickname cannot contain any of the following seven 
characters: 
[ ] _ " ' <space> <tab>

Protocol�TCP/IP is the only supported network protocol, so no 
selection is necessary.

Server Name�Enter the IP address (or DNS or hosts name) of the 
Fiery.

New Device�Enter the name of the device the Fiery is installed 
in: Sharp AR-C360P. This device name appears in the Printer 
Setup section of the Configuration page.

Note:Type Sharp AR-C360P exactly as shown because the device 
name is case-sensitive.

4. When you have added all the information, click Add.
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5. With the device name selected in the Devices list, click OK.

The Sharp AR-C360P appears in the list of available servers. The 
first line of the entry displays the nickname you gave the server, 
followed by the protocol. The second line displays the device 
name.

6. With the device name selected in the list of Available Servers, click Select 
to begin using ColorWise Pro Tools.

Modifying the configuration

Edit the configuration whenever there is any change in your 
original configuration, such as a change of IP address. Change the 
specific Fiery Setup information before using the following 
procedure to configure the connection.

To modify the configuration

1. To edit information for a Sharp AR-C360P in the list of available servers, 
select the Sharp AR-C360P by its nickname and click Modify. Edit 
information in the Modify Server Settings dialog box as necessary, and 
click OK.

2. To add a new Sharp AR-C360P to the list of available servers, click Add. 
Configure the Add New Server dialog box as outlined in steps 3 through 5 
in the preceding procedure.

3. To remove a Sharp AR-C360P from the list of available servers, select the 
Fiery by its nickname and click Remove.

Device name of the 
Fiery 
(Sharp AR-C360P)
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Configuring a connection for Fiery Spooler

Before you begin, print a Configuration page from the Printer 
Control Panel and note the IP address of the Sharp AR-C360P. See 
page 2-84.

To configure the connection for Fiery Spooler

1. Start the utility by double-clicking its icon.

The Chooser dialog box appears.

2. Click Option.

3. Click Add.

4. Enter the appropriate information for the Sharp AR-C360P.

Name�Enter the IP address (or DNS name) of the Sharp AR-
C360P.

New Device�Enter the name of the device that the Fiery is 
installed in: Sharp AR-C360P. This device name appears in the 
Printer Setup section of the Configuration page.

Note:Type Sharp AR-C360P exactly as shown because the device 
name is case-sensitive.

5. When you have entered all the information, click Add.

6. With the device name selected, click OK.

The Sharp AR-C360P appears in a list of configured servers.

7. Click OK in the Configure dialog box.

Fiery name and device 
name (Sharp AR-C360P)
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The Sharp AR-C360P appears in a list of available servers.

8. With the Sharp AR-C360P selected in the list of available servers, click OK 
to begin using Fiery Spooler.

Modifying the configuration

Edit the configuration whenever there is any change to your Sharp 
AR-C360P or network, such as an IP address or device change. 
Change the specific Fiery Setup information before configuring the 
connection.

To modify the configuration

1. In the Chooser dialog box, click Option.

2. To edit information for a Sharp AR-C360P, select the Sharp AR-C360P by 
its IP address or DNS name and click Modify. Edit information in the 
Settings dialog box as necessary, and click OK. 

3. To add a new Sharp AR-C360P, click Add. Configure the Settings dialog 
box as outlined in steps 4 through 6 in the preceding procedure.

4. To remove a Sharp AR-C360P, select the Fiery by its IP address or DNS 
name, and click Remove. 

The list of available servers reflects the modifications you have 
made.

Fiery name and device 
name 

(Sharp AR-C360P)
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Configuring a connection for Fiery Downloader

When you start Fiery Downloader, you must specify the 
connection to the Sharp AR-C360P.

Before you begin

� Print the Configuration page from the Printer Control Panel and 
note the AppleTalk zone of the Sharp AR-C360P. See page 2-84.

To specify a Sharp AR-C360P connection

1. Double-click the Fiery Downloader icon.

2. Select the AppleTalk zone in which the Sharp AR-C360P is located from 
the AppleTalk Zones  list.

The available servers appear in the Servers  list.

3. Select the Sharp AR-C360P in the Servers   list.

4. Click Connect.

The Fiery Downloader dialog box appears.

Fiery name and device 
name (Sharp AR-C360P)
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For information on how to use Fiery Downloader, see the 
Printing Guide.
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Configuring the connection for Command 
WorkStation LE for Mac OS X

The first time you start Command WorkStation LE, you are 
prompted to configure the connection to the Sharp AR-C360P.

Before you begin

� Print the Configuration page from the Printer Control Panel and 
note the IP address of the Sharp AR-C360P. See page 2-84.

To configure the connection for Command 
WorkStation LE

1. Start Command WorkStation LE.

The Available Servers dialog box is displayed. All servers found in 
the local subnet are displayed.

Note:The device name for the Fiery is Sharp AR-C360P.

2. If no Fiery servers were found, click the Manual tab to search by DNS 
name or IP address. Click Add to add the server to the Available Servers 
list.
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3. If no Fiery servers were found, click the Auto Search tab and then click 
Advanced to search by either a range of IP addresses or the IP address 
and subnet mask.

4. Click Search.

5. Select the Fiery server you want to use and click Add.

The selected Fiery server is displayed in the Login Server dialog 
box.
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6. Click the server name.

The Log In dialog box appears.

7. Select Administrator, Operator, or Guest and click Login.

8. If prompted, enter the password for Administrator or Operator. 

Your computer is connected to the server.

To modify the Command WorkStation LE connection to the Fiery, 
you must remove the server from the Login Server list and follow 
the procedure for configuring the connection.

Installing color files from CD2
You can copy additional color files from the CD2 to your hard disk. 
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Many of the files are PostScript files you can download and print 
using Fiery Downloader.

The Utilities CD (CD2) contains the following color files in the 
Extras folder:

ICC profiles 
(inside the 
ColorSync 
folder)

Install the ICC profiles into the ColorSync Profiles 
folder inside the System folder.

Mac Color 
Files folder 
(in the 
<language> 
folder)

CMYK Color Reference.ps, an 11-page, letter-size 
PostScript file to use for reference when defining CMYK 
colors in applications.

PANTONE Book.ps, a 19-page, letter-size PostScript 
file that indicates the closest equivalent of PANTONE 
coated colors that your Sharp AR-C360P can produce. 
The method used to print the PANTONE Book.ps file 
differs depending on the Spot Color Matching setting. 
For more information, see the Printing Guide and the 
Color Guide.

RGB page 01, a file you can print from Microsoft Word 
97 or later to view available RGB colors.

RGB page 02, a file you can print from PowerPoint 6.0 
or later to view available RGB colors.

Calibration 
folder 
(inside the 
<language>: 
Calibration 
folder)

Four measurements files of color patches: 
custom21.ps, custom34.ps, standard21.ps, and 
standard34.ps. The numbers in the file names refer to 
the number of patches on the page. The Custom files 
are provided to allow you to download measurement 
patches that incorporate the printer�s current 
calibration set. The Standard files are provided to 
allow you to download standard measurement patches 
that bypass the printer�s current calibration set. For 
information on using these files, see the Color Guide.

These files are provided for expert users and should 
not be used for day-to-day calibration.
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Loading ICC profiles

The ICC profiles installed are used with ColorWise Pro Tools and 
applications that support ICC standards. 

These instructions assume that you have already installed the ICC 
profiles included on CD2 inside the ColorSync folder. For more 
information, see �Installing color files from CD2� on page 2-93.

Note:The internal name of an ICC profile may vary slightly from 
its file name.

The following procedure describes installing the ICC profiles with 
ColorSync 4.0. For more information about ColorSync, see your 
application�s documentation.

To set the ColorSync system profile

1. Choose Control Panels : ColorSync from the Apple Menu.

2. Select EFIRGB ICC from the System Profile list.

When selected as the ColorSync system profile, EFIRGB ICC sets 
the optimal source color space for printing to the Fiery. The color 
space set by the EFIRGB ICC profile is the same as that set by the 
EFIRGB setting of the RGB Source Profile print option. 

Note:The RGB Source Profile print option setting overrides the 
ColorSync system profile setting.
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3. Close the ColorSync dialog box.

For more information about ICC profiles, see your Photoshop 
documentation.
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Loading the monitor settings file

The EFIRGB ICC monitor settings file can be used in Photoshop or 
other applications that support ICC profiles to define a source 
color space for printing to the Fiery.

To load the monitor settings file in Photoshop 5.x

1. Start Photoshop.

2. Choose Color Settings from the File menu, and choose RGB Setup from 
the Color Settings submenu.

3. In the RGB Setup dialog box, click Load.

4. Browse to the System :  Preferences :  ColorSync Profiles folder, select the 
EFIRGB ICC file, and then click Open.

Note:If you are using ColorSync 2.5, the ColorSync profile is 
located in System Folder : ColorSync Profiles.

The EFIRGB file appears as the selection.

5. Click OK.
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Loading the ICC printer profile

The ICC printer profile enables RGB-to-CMYK conversions that are 
specific to the kind of printer you are using.

To load the ICC printer profile in Photoshop 5.x

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose CMYK Setup from 
the Color Settings submenu.

3. In the CMYK Setup dialog box, choose ICC as the CMYK color model.

4. Select the profile that corresponds to the Fiery from the Profile menu.

5. Click OK.

For more information about ICC profiles, see your Photoshop 
documentation.

Loading monitor settings and the ICC device profile in 
Photoshop 6.x/7.x

In Photoshop 6.x and 7.x, you can load the monitor settings file 
and the ICC device profile at the same time.

To load the monitor settings file and the ICC 
device profile in Photoshop 6.x/7.x

1. Start Photoshop.

2. Choose Color Settings from the Edit menu and then choose Advanced 
Mode.

3. Choose EFI RGB from the RGB menu.

4. Choose the profile that corresponds to the Fiery from the CMYK menu.

5. Click OK.

For more information, see your Photoshop documentation.
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Fiery WebTools allow you to manage your Fiery remotely from the 
Internet or from your company�s intranet. The Sharp AR-C360P 
has its own home page, from which you can select a variety of 
functions.

For more information on using Fiery WebTools, see the 
Printing Guide.

Setting up Fiery WebTools
In order for network users to access and use Fiery WebTools, you 
must set specific Fiery options in Network Setup and Printer 
Setup. You also must prepare each user�s computer to 
communicate with the Fiery over the Internet or intranet.

For more information about Network Setup and Printer Setup, see 
Chapter 4 of the Configuration Guide.

To set up client workstations to use 
Fiery WebTools

1. Enable TCP/IP networking.

2. Make sure the workstation has a valid, unique IP address.

3. Make sure a supported Internet browser is installed on the 
computer.

For more information on supported browsers, see �System 
requirements� on page -12.

4. Make sure Java is enabled in your Internet browser.

For more information on setting up the Fiery and the network, see 
the Configuration Guide.

Chapter 3:
Setting Up 
Fiery WebTools
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This chapter provides troubleshooting tips.

On a Windows computer

Setting up printing on Windows NT 4.0 
or Windows 2000/XP/Server 2003 computers
If you have problems installing the Sharp AR-C360P with 
Windows NT 4.0 or Windows 2000/XP/Server 2003, try installing 
another PostScript printer (such as the Apple LaserWriter IIg), 
and then install the Sharp AR-C360P. Installing another printer 
ensures that all files are properly installed and available. For 
instructions, see your Windows documentation.

For information about problems you may encounter using the 
PostScript Printer Driver for Windows NT 4.0, see the Fiery Driver 
help file (EF8x3324.chm) included in \Drivers\English\nt40\ps on 
the Drivers CD (CD1). For Windows 2000/XP/Server 2003, see 
your Windows 2000/XP/Server 2003 documentation.

Reinstalling the Adobe PostScript Printer Driver 
on Windows 98/Me
If you are reinstalling the Adobe PostScript Printer Driver, delete 
any previous versions and related files before installation.

For additional information about problems you may encounter 
using the Adobe Printer Driver for Windows 98/Me, see the Fiery 
Driver help file (EF8x3324.chm) included in 
\Drivers\English\w9x\ps on the Drivers CD (CD1).

Chapter 4:
Troubleshooti
ng
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Problems with the Fiery utilities on Windows 
computers
If you are experiencing problems with connections for the Fiery 
utilities, try the following:

1. Make sure the TCP/IP networking protocol is enabled.

2. Make sure the connection is configured correctly for your site.

To check the current configuration, start a Fiery utility and choose 
Open from the File menu. Select the Sharp AR-C360P and click 
Modify to see current settings. If the settings are incorrect, you 
can change them in this dialog box.

On a Mac OS computer

Setting up the Fiery in the Mac OS 9 Chooser
If Auto-setup does not work and you are prompted to select the 
printer description file, select the appropriate Fiery file in your 
System :Extensions :Printer Descriptions folder.

Installing screen fonts

If you experience problems installing the PostScript screen fonts 
from CD1 to the System folder : Fonts folder, try the following:

1. Quit all applications and close all windows.

2. Create a new folder and name it �Uninstalled Fonts.�

This folder must be located outside the System folder.

3. Move fonts you are not using from the System folder : Fonts folder to the 
Uninstalled Fonts folder.

4. Install the fonts from CD1 to a folder called CD fonts. Copy the fonts to 
the System folder : Fonts folder.

5. Create aliases to the System folder : Fonts folder and the Uninstalled 
Fonts folder.

6. Place both aliases on your desktop.
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7. When necessary, use the aliases to open both folders and move fonts 
between them.

If you have any applications running, you must quit and restart 
them in order to view and use the newly installed fonts.

You can also try combining fonts from multiple suitcases into a 
single suitcase.

Setting up the Fiery in the Mac OS X Print Center 
If Auto-setup does not work and you are prompted to select the 
printer description file, select the appropriate Sharp AR-C360P file 
on your hard disk in the  System : Library : 
Printers : PPDs : Contents : Resources : language folder (for example, 
en.lproj folder).
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A
Adobe PageMaker for Windows, 

see PageMaker for Windows

C
Calibrat folder, for Windows 

users 1-75
Calibration folder, for Mac OS 

users 2-94
Chooser

setting up color server 
in 4-101

Clrfiles folder 1-75
CMYK Color Reference.ps 2-94
Cmyk_ref.ps 1-75
Color Files folder 2-94
Color Files folder, for Mac OS 

users 2-94
color reference files

for Windows users 1-75
ColorSync Profiles 2-82
ColorWise Pro Tools 1-65

configuring the connection to 
the Fiery

(Mac OS) 2-84
(Windows) 1-68

installing for Mac OS 2-82
installing for Windows 1-65

colour reference files 2-93
for Mac OS users 2-94

Command WorkStation 10
configuring the 

connection 1-70
installing for Windows 1-65

Command WorkStation LE
configuring the connection for 

Mac OS X 2-91

Configuration 
page 1-43, 1-55, 1-68

connecting
Windows 2000/XP with TCP/

IP 1-51
Windows 98/Me with parallel 

port 1-22
Windows NT 4.0 with parallel 

port 1-38, 1-50
connection on Windows, 

configuring 1-68 to 1-70
Custom21.ps (Mac OS) 2-94
Custom21.ps (Windows) 1-75
Custom34.ps (Mac OS) 2-94
Custom34.ps (Windows) 1-75

D
device name 1-69, 2-86, 2-87
DNS name 1-68, 2-87
Domain Name Server, see DNS
Driver CD

troubleshooting fonts 4-101
Drivers CD

contents (Mac OS) 2-81

E
Efirgb.icc monitor settings file for 

Mac OS 2-95
Efirgb.icm monitor settings file for 

Windows 1-76
E-mail printing, 

installing 1-59, 1-65

F
Fiery Downloader 1-65

installing for Windows 1-65
Fiery Spooler

configuring the connection on 
Mac OS 2-87 to 2-88

Index
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modifying the configuration 
(Mac OS) 2-88

Fiery utilities
configuring the connection on 

Windows 1-68 to 1-70
installing for Mac OS 2-82
installing for Windows 1-65
problems on Windows 4-101

Fiery WebTools
setting up 3-99
Status 11
WebDownloader 11
WebLink 11
WebSetup 11

fonts
installing 4-101

Fonts folder 4-101
Frame Type option 1-27

I
ICC device profile 2-98

loading in Photoshop 4.0 
(Mac OS) 2-98

loading in Photoshop 6.x 
(Mac OS) 2-98

ICC monitor settings profile, 
specifying in Photoshop 
(Mac OS) 2-97

Icm folder (Windows) 1-75
Installable Options

specifying, from Windows 
2000/XP printer driver 1-47

specifying, from Windows 98 
printer driver 1-20

specifying, from Windows 98/
Me printer driver 1-20

specifying, from Windows NT 
4.0 printer driver 1-36

specifying, from Windows NT 
printer driver 1-36

Installers

Windows 1-65
installers

Mac OS 2-82
Installing

Adobe PostScript printer, 
Windows 2000/XP/
Server 2003 1-44

Adobe PostScript printer, 
Windows 98/Me 1-17

Adobe PostScript printer, 
Windows NT 4.0 1-33

Command WorkStation 1-65
PCL printer driver, Windows 98/

Me 1-17
software for Windows 1-65

installing
Mac OS software 2-82
software for Mac OS 2-82

IP address 1-70
IPP printing setup

on Windows 2000/XP/
Server 2003 1-57 to 1-58

on Windows 98/Me 1-32
IPX

printing for Windows 2000/XP/
Server 2003 1-53 to 1-54

printing for 
Windows NT 4.0 1-41

Windows 2000/XP/
Server 2003 1-52

Windows NT 4.0 1-39
IPX/SPX

Windows 2000/XP/
Server 2003 1-52

Windows NT 4.0 1-39

J
Java 1-65, 3-99
Java Runtime Environment 

(JRE) 1-65
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JRE, see Java Runtime 
Environment 1-65

M
Mac OS X

setting up server in 4-102
Mac OS

copying colour files 2-93
installing Fiery 

utilities 2-81, 2-82
installing software 2-82
printer setup 2-81
troubleshooting 4-101

monitor settings file, Mac OS 2-97

N
NetWare client setup

Windows 98/Me 1-29
Windows 2000/XP/

Server 2003 1-52
Windows NT 4.0 1-39

P
PageMaker for Windows 1-80
PANTONE Book.ps 2-94
PANTONE.ps 1-75
parallel port

Windows 98/Me 1-22 to 1-26
PCL printer driver

Windows 98/Me 1-17 to 1-19
Photoshop 5.0

loading the ICC device settings 
profile (Mac OS) 2-98

loading the ICC monitor 
settings file (Mac OS) 2-97

loading the ICM device profile 
(Windows) 1-78

loading the RGB working space 
profile (Windows) 1-77

Photoshop 6.x
loading the ICC device settings 

profile (Mac OS) 2-98

loading the ICC monitor 
settings file (Mac OS) 2-98

loading the ICM device profile 
(Windows) 1-79

loading the ICM monitor 
settings file (Windows) 1-79

PostScript
printing from Mac OS 2-81 to 

??
printing from 

Windows 1-17, 1-44
PostScript printer driver

Windows 2000/XP/
Server 2003 1-44

Windows 98/Me 1-17
Windows NT 4.0 1-33 to 1-35

PostScript printing
Windows 98/Me 1-17

PowerPoint, RGB color reference 
file 2-94

PPD
copying files for Windows 

applications 1-80
selecting the PPD in the 

Chooser 4-101
selecting the PPD in the Print 

Center 4-102
Print Center

setting up server in Mac 
OS X 4-102

Printer Driver, installable options
Windows 2000/XP/

Server 2003 1-47
Windows 98/Me 1-20
Windows NT 4.0 1-36
Windows 98 1-20
Windows NT 1-36

Printer drivers, see PostScript 
printer drivers

printer setup
Mac OS 2-81
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Printing
Windows 2000/XP 1-49
Windows 2000/XP/

Server 2003 1-49
Windows NT 4.0 1-38

printing
see also PostScript printing

R
RGB page 01 2-94
RGB page 02 2-94
Rgb_01.doc 1-75
Rgb_02.ppt 1-75

S
screen fonts 4-101
SMB printing setup

on Windows 2000/XP/
Server 2003 1-54 to 1-56

on Windows 98/Me 1-29 to 
1-31

on Windows NT 4.0 1-41 to 
1-43

Stand21.ps (Mac OS) 2-94
Stand21.ps (Windows) 1-75
Stand34.ps (Mac OS) 2-94
Stand34.ps (Windows) 1-75
Status WebTool, see Fiery 

WebTools
Sun Java file 1-65

T
troubleshooting

Mac OS computers 4-101
Windows computers 4-100

U
Uninstalled Fonts folder 4-101
User Software CD

contents (Windows) 1-65
Utilities CD

installing from, for 
Mac OS 2-93

W
WebDownloader WebTool, see 

Fiery WebTools
WebSetup WebTool, see Fiery 

WebTools
Windows

copying color files 1-75
installing Fiery utilities 1-65
troubleshooting 4-100

Windows 98/Me
parallel port 1-22 to 1-26
setting up PostScript 

printing 1-17
SMB printing 1-29 to 1-31
troubleshooting 4-100

Windows 2000/XP
printing requirements 1-49
setting up PostScript 

printing 1-44
troubleshooting 4-100

Windows 2000/XP/Server 2003
IPX 1-53 to 1-54
IPX/SPX 1-52
printing requirements 1-49

Windows NT 4.0
IPX 1-41
IPX/SPX 1-39
PostScript printer driver 1-33
printing requirements 1-38
troubleshooting 4-100

WINS Name Server 1-43, 1-55
Word, RGB colour reference 

file 2-94
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